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Chapter 1. Overview and Installation

To ease the process of application development, the importance and availability of supporting tools
for microcontrollers cannot be underestimated. To support its range of MCUs, the company is
fully committed to the development and release of easy to use and fully functional tools for its full
range of devices. The overall development environment is known as the IDE, while the operating
software is known as the HT-IDE3000. The software provides an extremely user friendly Windows
based approach for program editing and debugging while the ICE and e-ICE emulators and OCDS
hardware provides full real time emulation with multi functional trace, stepping and breakpoint
functions. With a complete set of interface cards for its full device range and regular software
Service Pack updates, the IDE development environment ensures that designers have the best tools
to maximize efficiency in the design and release of their microcontroller applications.

IDE Development Environment

The Integrated Development Environment, otherwise known as the IDE, is a high performance
integrated development environment designed around the company’s series of 8-bit MCU devices.
Incorporated within the system is the hardware and software tools necessary for rapid and easy
development of applications based on the company range of 8-bit MCUs. The key component
within the IDE system is the ICE, e-ICE or OCDS Emulators and Debuggers, capable of emulating
the company 8-bit MCU in real time, in addition to providing powerful debugging and trace
features. As for the software, the HT-IDE3000 provides a friendly workbench to ease the process
of application program development, by integrating all of the software tools, such as editor, Cross
Assembler, Cross Linker, library and symbolic debugger into a user friendly Windows based
environment. In addition, the HT-IDE3000 provides a software simulator for some devices which
is capable of simulating the behavior of the company’s 8-bit MCU range without connection to a

hardware emulator.

More detailed information on the HT-IDE3000 development system is contained within the HT-
IDE3000 User’s Guide. Installed in conjunction with the HT-IDE3000 and to ensure that the
development system contains information on new microcontrollers and the latest software updates,
the company provides regular HT-IDE3000 Service Packs. These Service Packs, which can be
downloaded from the the company website, do not replace the HT-IDE3000 but are installed after
the HT-IDE3000 system software has been installed. Some of the special features provided by the
HT-IDE3000 include:

Emulation
Real-time program instruction emulation
Hardware

» ICE
+ Easy installation and usage
+ Either internal or external oscillator
+ Breakpoint mechanism
+ Trace functions and trigger qualification supported by trace emulation chip
+ Printer port for connecting the ICE to a host computer
+ 1/O interface card for connecting the user’s application board to the ICE
e e-ICE
+ Easy installation and usage
+ Either internal or external oscillator

+ Breakpoint mechanism
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+ USB cable for connecting the e-ICE to a host computer
+ 2.54mm standard pins for connecting the user’s application board to the e-ICE
* e-Link

¢ The EV uses an OCDS — On-Chip Debug Support — architecture, which only requires two
signal lines for debug

+ The EV has the same number of pins as the IC or 1~2 more pins than the IC. It can be soldered
to the application board and easily debugged.

+ Contains several types of breakpoint functions

+ Includes RAM real-time monitoring function

+ Wide operating voltage range of 1.7V~5.5V

» Software

+ Windows based software utilities

+ Source program level debugger — symbolic debugger

+ Workbench for multiple source program files — allows for more than one source program file in
one application project

+ All tools are included for the development, debug, evaluation and generation of the final
application program code

+ Library for the setting up of common procedures which can be linked at a later date to other
projects.

In-Circuit Emulator — ICE, e-ICE and e-Link

Developed alongside the the company 8-bit microcontroller device range, the company ICE is a fully
functional in-circuit emulator for the company’s 8-bit microcontroller devices. Incorporated within
the system are a comprehensive set of hardware and software tools for rapid and easy development
of user applications. Central to the system is the in-circuit hardware emulator, capable of emulating
all of the company’s 8-bit devices in real-time, while also providing a range of powerful debugging
and trace facilities. Regarding software functions, the system incorporates a user-friendly Windows
based workbench which integrates together functions such as program editor, Cross Assembler,
Cross Linker and library manager.

ICE Interface Card

The interface cards supplied with the ICE can be used for most applications, however, it is possible
for the user to omit the supplied interface card and design their own interface card. By including the
necessary interface circuitry on their own interface card, the user has a means of directly connecting
their target boards to the CN1 and CN2 connectors of the IE.

Fig 1-1
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System Configuration

The IDE system configuration is shown below, in which the host computer is a Pentium compatible
machine with Windows XP or later. Note that if Windows XP or later systems are used, then the HT-
IDE3000 software must be installed in the Supervisor Privilege mode

Power Adapter
Emulator
Flat Cable
| =
T T Printer Cable Emulator Box Interface Target
- = ‘ . ICE Card Board
Fig 1-2

The IDE system contains the following hardware components:

ICE
+ The ICE box contains the emulator box with 1 printer port connector for connecting to the host
machine, I/O signal connector and one power-on LED
+ 1/O interface card for connecting the target board to the ICE box
+ Power Adapter, output 16V
+ 25-pin D-type printer cable
¢+ Integrated MCU writer
e-ICE
¢ The e-ICE basically consists of two boards, a mother board, known as the MEV, and into
which is plugged a device daughter board, known as the DEV.
+ 5-pin Mini-B USB cable
e-Link
+ e-Link device
+ 2%6 double row male headers
+ Flat-Cable pin connector 2x6 female headers — 25cm
+ e-FPCO6A
+ USB cable
+ Important note card
+ Software CD

Installation

System Requirement
The hardware and software requirements for installing HT-IDE3000 system are as follows:
+ A PC running Microsoft Windows Operating system (32-bit or 64-bit)
+ Atleast 1G RAM for best performance
+ At least 500M free disk space
+ Parallel or USB port to connect PC and ICE

Rev. 1.30 6 May 09, 2022
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Hardware Installation
The company provides three kinds of ICE for the user to choose, as follows:
ICE
e Step 1
Install the Driver if this is the first use.
e Step2
Plug the power adapter into the power connector of the ICE
* Step 3
Connect the target board to the ICE by using the I/O interface card or flat cable
* Step 4
Connect the ICE to the host machine using the printer cable. The LED on the ICE should now be
lit, if not, there is an error and your dealer should be contacted.

Caution: Exercise care when using the power adapter. Do not use a power adapter whose output
voltage is not 16V, otherwise the ICE may be damaged. It is strongly recommended that
only the power adapter supplied by the company be used. First plug the power adapter to
the power connector of the ICE.

e-ICE
e Step 1
Install the correct DEV board for the MCU to be emulated
* Step 2
Use the USB cable to connect the e-ICE to the PC. The LED on the ICE should now be lit, if not,
there is an error and your dealer should be contacted.
e-Link
e Step 1
Connect the EV board to the e-Link using the flat cable
* Step 2
Use the USB cable to connect the e-Link to the PC. The LED on the e-Link should now be lit, if

not, it must be reconnected or contact your agent.

Caution: The HT-IDE3000 software version must be 7.6 or above when using the e-Link to debug.

Software Installation
e Step 1
First click on the HT-IDE3000 install icon to start the HT-IDE3000 installation.
e Step2
Press the <Next> button to continue setup or press <Cancel> button to abort.

Rev. 1.30 7 May 09, 2022
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{8 Setup - Holtek HTIDE3000 v7.93 % b= ]

Welcome to the Holtek
HT-IDE3000 V7.93 Setup Wizard
This will install Holtek HT-IDE3000 ¥7.93 on your computer,

Itis recommended that you dlose all other applications before
continuing.

Click Mext to continue, or Cancel to exit Setup.

Mext = ]l Cancel

Fig 1-6

e Step3
The following dialogue will be shown to ask the user to enter a directory name.

5 setup - Holtek HT-IDE2000 47.93 =

Select Destination Location
‘where should Holtek HT-IDES000 ¥7.93 be installed?

Setup will install Halkek HT-IDE3000 ¥7.93 into the Following Folder,

To continue, click Mext, IF vou would like to select a different Folder, click Browse,

C:\Program FilesiHoltek MCU Development Toolsi\HT-IDE3000YT Browse, ..

Ak least 223.2 MB of free disk space is required,

Mext = ]| Cancel

Fig 1-7
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15! Setup - Holtek HT-IDE3000 v7.93 [ @ |[=Es]

Ready to Install

Setup is now ready to beqgin instaling Haoltek HT-IDE3000 ¥7,93 on yaour
compuker,

Click Install to continue with the installation, or click Back if you want to review or
change any settings,

Destination location: »
C:\Program Files\Holtek MCU Development Tools\HT-IDE3000YT, x

< Back I[ Install ] [ Cancel

Fig 1-8

e Step4
Specify the path you want to install the HT-IDE3000 to and click the <Next> button.

e Step 5
SETUP will copy all files to the specified directory.

15! Setup - Holtek HT-IDE3000 7.93 = = s

Installing
Please wait while Setup installs Holtek HT-IDE3000 ¥7.93 on vour computer,

Extracting files. ..
. AHT-IDE3000YT A DOCYHT-IDES000 Programmer Guide For C Language(950), pdf

Cancel

Fig 1-9

Rev. 1.30 9 May 09, 2022



HDLTEK# HT-IDE3000 User’s Guide

e Step6
If the process is successful the following dialogue box will be shown.

i5 setup - Holtek HT-IDE3000 47.93 o | ==

Completing the Holtek
HT-IDE3000 ¥7.93 Setup Wizard

Setup has finished installing Holkek HT-IDE3000 %793 on your
computer, The application may be launched by selecting the

inctalled chorbe ks

-

If this is the first installation of HT-IDE3000, please restart vour
computer.

Fig 1-10

e Step7
Press the <OK> button and then press the <Finish> button to finish the setup. If this is the first
installation of HT-IDE3000, please restart the computer system.

Rev. 1.30 10 May 09, 2022
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Chapter 2 Quick Start
This chapter gives a brief description of using HT-IDE3000 to develop an application project.

Step 1: Create a New Project with the CodeWizard
 Click on the Project menu and select New command

+ Enter a project name and select an MCU from the combo box

* Choose the file type from either .ASM or .C.

* Click on the Next button and the system will ask you to setup the configuration options
* Setup all configuration options and click on the OK button

* Finally, click OK when you have confirmed the Project Setting options

Step 2: Build the Project
* Click on Build menu and select the Build command
* The system will assemble/compile all source files in the project
+ If there are errors in the programs, double click on the error message line and the system will
prompt you to the position where the error has occurred
+ Ifall the program files are error free, the system will create a Task file and download it to the
ICE for debug

» These steps can be repeated until the program is fully debugged

Step 3: Programming the MCU Device
* Build the project to create the .OTP file
* Use the general-purpose writer e-WriterPro together with the HOPE3000 to program the MCU

devices

Step 4: Transmit Code to the company
* Click on the Project menu and select the Option Table Viewer command. Fig 2-1 will then be
displayed, after which click on the Print button to print the configuration options

* Send the .COD/.OTP/.MTP file and the Option Approval Sheet to the company

Rev. 1.30 11 May 09, 2022
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§1 [ =rs\AdministratoiDocuments\HTE. ProjecfHT46CU25\HT46CU25.COL| [Bl‘uwse H Print J

Product Hame : il
HMCU Hame : HT44CU25

File Hame :© C:\USERSAADHINISTRATOR\DOCUMENTSYHTK_PROJECTAWHTA46CUZS5\HT4G6CU25
HT-IDE Uer. - U7.93

Compiler Uer. : U3.42 E
Linker Ver. : V8.7

CFG Uer. - U1.3

MASK File Checksum:[ 6BB7H ]
Program Checksum:[ 813AH ]
Program+Option Checksum:[ 813aH ]

Pull-high PC Hon-Pull-high

Pull-high PD Hon-Full-high

Pull-high PF Non-Pull-high

Pull-high PG Hon-Full-high

PAZ/PFD Disable FFD

PFD clock source TIMER B8 i

_f--lu - nm - - 2
Fig 21
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The Programming and data flow is illustrated by the following diagram:

ASM Projectffe
Assemblef/Compile+
| -H+ *  ce »
J

'UE = ||
o

Build#+
Rebuild All+

_., -
1.Assemble/C ompile+ Tools# Linker«
2_Linker+ Library Manager+ —*| Create Task File+
3.Loader+

4_Code Generator+

Debugi/

Loader+ Gov
CFGY TSk« Download to ICE+ [ Go to Cursor

Jump to Cursor+
StopfT race Stop+

v ﬁ
Toolsi Reset
) -OFT+ Code Generator+ Power-on Reset.
Mask Opton+ Reset Trace+
Step IntosOverfOuts
Stepping+
OTP+

Toolsé chI :::Ej L Tools#
. - o . 1+ -
Print Option Table+ OnBoard Writer«
¢ v

Option+ Holtek+ o Masks

Approval Sheet ICs+

Fig 2-2
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Chapter 3 Menu - File/Edit/View/Tools/Options

This chapter describes some of the menus and commands of the HT-IDE3000. Other menus are
described in the Project, Debug and Window chapters.

Start the HT-IDE3000 System

iai! Default Programs
[t/ Desktop Gadget Gallery I
& Internet Explorer

] Windows DVD Maker

555 Windows Fax and Scan
 Windows Media Center
|Z| Windows Media Player

holtek

Documents

Wlnd?ws Update Pictures
w4 XPS Viewer

. T-Zip Music

| Accessories

. Games Computer

. Holtek MCU Development Tools

. HT-IDE3000 Control Panel

m BinToAsm
«* Diagnosis Devices and Printers
T HT-IDE3000 User's guide
HT-IDE3000 Default Programs
. Library Manager
& Option Viewer Help and Support

1 Back

Fig 3-1
* Click the Start Button, select Programs and select HT-IDE3000
¢+ Click the HT-IDE3000 icon

» Fig 3-2 will be displayed if the following conditions occur.
+ No connection between the ICE and the host machine or connection fails.
+ The ICE is powered off.

" HT-IDE3000 ==

-

l L Unable to connect to Holtek ICE.

| Rety || Cancel

Fig 3-2

If “Retry” is selected and the connection between the ICE and the host machine has been made, then
Fig 3-3 will be displayed, the HT-IDE3000 will enter the emulation mode and the ICE begins to
function.

Rev. 1.30 14 May 09, 2022
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A Holtek ICE is connected to e-ICE.

QK

Fig 3-3

The HT-IDE3000 software includes File, Edit, View, Project, Build, Debug, Tools, Options, Window
and Help menus. The following sections describe the functions and commands of each menu.

A dockable toolbar, below the menu bar (Fig 3-4), contains icons that correspond to, and assist the
user with more convenient execution of frequently used menu

commands. When the cursor is placed on a toolbar icon, the corresponding command name will be
displayed alongside. Clicking on the icon will cause the command to be executed.

A Status Bar, in the bottom line (Fig 3-4), displays the emulation or simulation present status and
the resulting command status. In the status bar, the field (PC=0001H) displays the Program Counter
while in debugging process (Debug menu).

b [E=5Eoh =
© File Edit View Project Buildl Debug Toolks Options Window Help

DEHE & BB 0> R &S 5 BN R

BN ElaM g

R AN U RSN -

‘4 »
[Awork..[FCless . (@ Docn.. | = Ovur [GyFind in Fles | 31 Watch | S5l Wathd | 551 Wetch | 5] Wanchd | =] Ao | iiLacal | [ Bookmarks
Resdy Lul,Coll  DISCONNECT Emulsion PC-2000H Reset OVR CAF OO

Fig 3-4
The Status Bar contains information that may be useful during program debug. The Program
Counter is used during program execution and indicates the actual present Program Counter value
while the row and column indicators are used to show the present cursor position when using the
program editor.

Rev. 1.30
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File Menu

New Open Save
~
D@ 4 E

=i [CE® &

- & v B

The File menu provides file processing commands, the details behind which are shown in the

following list along with the corresponding toolbar icons.

New

Create a new file
Open

Open an existing file
Close

Close the current active file

Save
Write the active windows data to the active file

SaveAs

Write the active windows data to the specified file
Save All

Write all windows data to the corresponding opened files
Print

Print active data to the printer

Print Setup

Setup printer

PrintPreview

Preview the printed output

Recent Files

List the most recently opened and closed four files
Exit

Exit from HT-IDE3000 and return to Windows

Edit Menu

W=2= N IR

2o DR & &
FlN

Cut Copy Paste

Undo

Cancel the previous editing operation

Redo

Cancel the previous Undo operation

Cut

Remove the selected lines from the file and place onto the clipboard
Copy

Place a copy of the selected content onto the clipboard

Paste
Paste the clipboard information to the present insertion point

Rev. 1.30

16

May 09, 2022



HT-IDE3000 User’s Guide HDLTEK#

Delete
Delete the selected content

Select All

Select the entire document

Find

Search the specified word from the editor active buffer
Find Next

Find the next occurrence of the specified text

Find Previous

Find the previous occurrence of the specified text

Find in Files

Search for a string in multiple files

Replace

Replace the specified source word with the destination word in the editor active buffer

Go To...
Moves to a specified location

Read Only
Read only mode

View Menu

The View menu provides the following commands to control the window screen of the HT-IDE3000.
(Refer to Fig 3-5)

Full Screen
Toggles Full Screen Mode on/off

Appliaction Look
Multiple styles can be selected: Office XP, Windows XP, Office 2003, Visual Studio .Net 2005,
Office 2007 (including blue, black, sliver and green), Visual Studio .Net 2005 is as the default.

Restore Default LayOut
Restore the default layout, this command will restart the program automatically.

Toolbar

Display the toolbar information on the window. The toolbar contains some groups of buttons
whose function is the same as that of the command in each corresponding menu item. When
the mouse cursor is placed on a toolbar button, the corresponding function name will be
displayed next to the button. If the mouse is clicked, the command will be executed. Refer to the
corresponding chapter for the functionality of each button. The Toggle Breakpoint button will set
the line specified by the cursor as a breakpoint (highlighted). The toggle action of this button will
clear the breakpoint function if previously set.

Status Bar
Displays the status bar information on the window.

Display Line Numbers
Toggle line numbering on and off in your code.

Cycle Count

Count instruction cycles accumulatively. Press the reset button to clear the cycle count. The
Hex and Dec buttons are used to change the radix of the count, hexadecimal or decimal. The
maximum cycle count is 65535.

Rev. 1.30
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Note: There is a slight difference of maximum cycle count between two kinds of ICE, the maximum
cycle count of e-ICE can up to 4294967295 while ICE can only count to 65535.

X HT-IDE2000 [E=3 BN =5
Fle Efit |View | Pojert Euill Debug Took Options Window Help
[ @& | [E P oE & @ - #h v R

5 1Y b Toalbar r
2,0 ([ ] o Ber

O 0 0| ovEsimlok Y] Fdoysz00

Restore Defonlt Layout Oftize ZP

Windows XP

Offise 2003

Cyele Count e | isual Studio NET 2005
Office 2007 » -

E‘ Display Line Numbers

7 b

| SAWork .. [E3Cless .. |@Doc.. | =] Ovtput |G Find in Files | Jig] Wetchl | jgl Wateh2 | ad Weteh3 | jgd Wetchd | g Ato | GlLocel | i Baokmarks
Ready Lnl,Coll  DISCONNECT Emulstion PC=2000H Resst OFR

Fig 3-5

Tools Menu

The Tools menu provides the special commands to facilitate user application debug. These
commands are Configuration Options, Import Configuration Options, Diagnose, Writer, Library
Manager, Editor, LCD Simulator, Voice & Flash Download and Switch OCDS Mode.

HT-IDE3000 e
File Edit View Project Buld Debwg | Took | Options Window Help
D@ HE & BR[| ConfiewstionOptions - .
B #4 p [2) ) G Fi L Import Configuration Options -
Bodn EE B Diagnose
08843 & e
= Program Losation Manager
3 Cade Generator
Editor 3
LCD Simulator
Woiee & Flash Downlosd i
Switch OCDS Mode
Smart Progremming Seftings
ICF |
2] »

| A Work . [F3Clss | @ Doon =] Output |S4Find in Files | Z5] Waichl | 5] Waich2 | E Waich? | F5l Watchd | ] Autn | FZ]Locsl | | Bookmarks
Realy Lnl,Coll  DISCONNECT Emulstion PC=2000H Resst OVR

Fig 3-6

Configuration Option

This command generates an option file used by the Build command in the Build menu. The contents
of the option file depend upon the specified MCU. This command allows options to be modified
after creation of the project.

Choosing the Clock Source

When creating a new project or modifying the configuration options, it is necessary to choose an
internal or external clock source for ICE.

If an internal clock source is used, the system application frequency has to be specified. The HT-
IDE3000 system will calculate a frequency which can be supported by the ICE, one which will be
the most approximate value to the specified system frequency. Whenever the calculated frequency
is not equal to the specified frequency, a warning message and the specified frequency along with
the calculated frequency will be displayed. Confirmation will then be required to confirm the use of
the calculated frequency or to specify another system frequency. Otherwise an external clock source
is the only option. No matter which kind of clock source is chosen, the system frequency must be
specified.

Rev. 1.30
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Note: More information about choosing the clock source for e-ICE, please refer to the e-ICE User’s
Guide.

Import Configuration Options
Import the configuration options files.

Diagnose
This command (Fig 3-7) helps to check whether the ICE is working correctly. There are a total of 9
items for diagnosis. Multiple items can be selected by clicking the check box and pressing the Test
button, or press the Test All button to diagnose all items. These items are listed below.
* MCU resource option space
Diagnose the MCU options space of the ICE.
* Code space
Diagnose the program code memory of the ICE.
» Trace space
Diagnose the trace buffer memory of the ICE.
» Data space
Diagnose the program Data Memory of the ICE.
» System space
Diagnose the system Data Memory of the ICE.
« JOEVO
Diagnose the I/0 EV-chip in socket 0 of the ICE.
« J/OEV1
Diagnose the I/O EV-chip in socket 1 of the ICE.
« JOEV2
Diagnose the 1/0 EV-chip in socket 2 of the ICE.

«# HT-ICE Diagnosis - Connect to LPTL [==3a]

Options
ru

|7 Codespace  HTG2190 {« Others
[~ Trace space

[ Data space

[~ System space

I 0Ev¥D

[~ 0B 1

[~ I0EY2

Test Al Test Close

Fig 3-7
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The Library Manager command, in Fig 3-8, supports the library functions. Program codes used
frequently can be compiled into library files and then included in the application program by using

the Project command in the Options menu. (Refer to the Cross Linker options item in the Options
menu, Project command). The functions of Library Manager are:

* Create a new library file or modify a library file
* Add/Delete a program module into/from a library file

» Extract a program module from a library file, and create an object file
Part III gives more details on the library manager.

& HLIBW

Library Namme:

Mew Open
Ohject in Library: Ohiject in Directory:

o]

Ohjects' information Directaries:

o Browze

Add Sption

¥ Remove debug info

Ahout Qi

Fig 3-8
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Program Location Manager

The position of each module in the memory can be setup by the user, see Fig 3-10.

Program Location Manager @

Tvpe F.omn size: OH ~ 1FFFH

File: Start address End address
HT&EF50.C

LIEHOLTERGCC,.LIE

startupl |, asm

v3_tabrd_nirsc.lib

Reset: ] [ Sek oK ] [ Cancel
Fig 3-10
* Type
Types of module. These can be C, ASM, OBJ or LIB.
e Set

Select modules in listbox (use the Shift key or Ctrl key to select more than one module) and then
click the Set button. This will generate the following dialog:

Rom address settings @
File:  C:YUsersiholtek!DocumentsiHTK_ProjectiHTEEFS0LHT

PROM size: OH ~ 1FFFH

Stark Addr 0x End Addr 0x

[ OK ] ’ Cancel

Fig 3-11

Finally enter the start address and end address.

Tip: Removing the start address and the end address can reset the module settings
* Reset

Clear all settings

Additionally this can be setup from the workspace.
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HT-IDE3000 - C:\Users\holtek\Dacuments\HTK_Project\HT66FS0\HT66F50. pjtx
File Edit View Pojst Builldl Debug Tools Options Window Help

DEHE =8 - #h R
& g 5L D S
BRfn L£FL T
COQ a2 @,
-
[ HT66F50.c
= Project: HTB6FS0 (%) 1 #include "HT66F50.h"
© < MCU: HTE6F50 o include -
B {E”KEF”ES 3 void main()
H L]
©0J Stap | Drectsstting I_ProjechHTEBF SOHTEEF50.C
T Open Broject
[ L)1) 44, Files to Project 3
ol Hea Close Project
. 5 Bl e project
:% Rename Project (F2)
Delets Praject
Setas Active Project
Lmport Project HT66F50.c X b
Export Projest
Canfiguration Option p
Program Location Setings
= Open CtlO
Remave From Target
File Properties -
a1 =1 Exclude Fy Target
CAWez . [ e fom e Files [ 1 Watchl | B3l Warh2 | B3 Watch3 | ] Watchd | Bl Auo | Ellocel [l Bookmasks
Ln7,Col2 DISCONNECT Emulstion PC=2000H

Fig 3-12

V3 Code Generator

This V3 Code Generator is used to generate specific syntax codes for users, as shown below.

coe V3 Code Generator EII = I@
CodeType: [Bit Variable v] Language:

Bit Variable
|| saveToFile Dir: | CiiUsersiholkek)Documents\HTE_ProjectiHTEEFS0 .| CFle  |H_bit.c
Bithame: b2 yolatile  [V]abs Addr Addr 0x 140 phe O hit HFle H_bith
Bit Mame Yolatile Eit Addr Bt Mum ByteTypehame:
b1 b
its
& Y e ’ §
Eyketariablehame:
var %
Code:
unsigned char b0 : 1; -
unsigned char b7 : 1;
+ _bits; =
exkern _bits var_0;
#define bl war_0.bD
skatic volatile _bits war_1 _ attribute_ ({at{0x14000);
#define b2 var_1,bD ™
4 [

Rev. 1.30 22 May 09, 2022



HT-IDE3000 User’s Guide HDLTEK#

* CodeType
Generated code types.

1) Bit Variable
To generate Bit variables.

Bit Variable
[T 5aveToFile Dir: CiiUserstholekiDocumentsiHTE _ProjectiHT66FS0 .| cFile H_bit.c
BitName: b2 yolatile  [¥]abs addr  Addr: 0x 140 e O bit HFile  |H_bit.h
Eit: Marne Wiolatile Bit: Addr Eit: hurn ByteTypehlame:
b1 b
ByteVariableMame:
var_d

SaveToFile: Select to save the generated code to a specified file.

Dir: The file location.

CFile and HFile: The file names of the C file and H file that is to be saved.
ByteTypeName and ByteVariableName: To specify the format of the Byte Type Name and Byte
Variable Name.

Volatile: To specify the bit variable as volatile.

Abs Addr: Select to specify the bit variable at a specific bit of a specific address.
Add: To add a bit variable into the list.

Del: To delete the selected bit variable from the list.

Del All: To delete all the bit variables from the list.

The added bit variables can be re-edited by double clicking the bit variable list.

2) ISR (Interrupt Function)
To generate interrupt functions.

I5R

ISR Mame  ist3 ISR vector: Ox © []15R Location: x| 100

ISR Mame: ISR Yector ISR Lacation
isr1 Ox4 Ox100

o o
isr3 Oxc

Del Al

Code!
void __attributed{interrupt(0x043, at(0x 1000) isr L{vaid)
4
¥
woid __aktributed(interrupk(0x08))) isr2{vaid)
1

e _attribute((interrupt(0x0CY)) isr3(void)

;
ISR Name represents the interrupt function name. ISR Vector represents the interrupt vector
address. ISR Location represents the specific interrupt function location.
The added interrupt function can be re-edited by double clicking the interrupt function list.
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3) Abs Addr Variable (Absolute Address Variable)
To generate absolute address variables.

Abs Addr Yariable
Type: int* v Mame: arrav[20]  addr: 0x 180 [T]canst  Initial value: |10
Variable Type Yariable Name Yariable Addr const  Initial Yalue
unsigned char a 0xa80
unsigned char b 0x51 + 10
int* array[20] 0x180
Code:

static volatile unsigned char a __ attribute_ {{at{0x2003);
const unsigned char b __attribute_ {{ati0x&1))) = 10;
skatic volatile int* array[20] __ attribute_ {{ab{0x18000);

Type, Name and Addr represent the variable type, variable name and variable address
respectively. The variable name can be an array. Const can be selected to specify a const variable.
A const variable must have an initial value.

The added variable can be re-edited by double clicking the variable list.

4) Delay Function
To generate delay functions.

Delay Function

Functiontlame: fun ParamType: unsignedlong
Function Marme Param Type
fun unsigned long
Code:

void Funfunsigned long count)
wolatile unsigned long i;
fForfi=0;i<count;i++)
asmi"nop"y;

FunctionName represents the Delay Function name, ParamType represents the function
parameter type.
The variables within a Delay Function must be defined as volatile, otherwise, the loops will be
optimised by the V3 compiler.
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5) Inline Asm (Inline Assembly)
To generate inline assembly codes. It converts the input ASM instructions into V3 format inline
assembly codes.

Inline Asm

jmp $+1 -
15et acc

mow a,0

imp §

4 L

Code:

asm{"jmp $+1";
asmi"'mow a,0");
asm{"jmp §");

6) Function
To generate functions. Users can define the return type, parameters, specified function location
and whether it is an entry function.

Function
Returnint ¥ FunctionMame: funl Function Location: 0x 150
ParamType: long - pararm List ["] Entry Function
unsigned char a
Param Mame: b long b
Code:
__attribute_ {{ak{0x1500)) -

int funi{unsigned char a,long b)

return O;

Return and FunctionName: Function return type and function name
ParamList: Function parameter list

Function Location: Specified function location

Entry Function: Select it to define an entry function

Add: To add a parameter to the function parameter list

Del: To delete the selected parameter from the list
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7) Specified Range Variable
To generate specified range variables. It automatically distributes the variables in the specified

range according to the variable length.

Specified Range Variable

SpecifiedRange:  0x 01

Type: double

&0 o O

1FF

» Typelength: |4

Byte Mame: ©

Variable Type
char®

shart:

float

double

Type Length
2

z
3
4

Variable Mame
pa

arr[10]

b[z]

c

Code:

skatic volatile char® pa __attribute_ {{at{0x18003);
skatic volatile short arr[10] __attribute_ {{at{0x1823));
static volatile float b[2] __ attribute_ ({atiDx196))0;
static volatile double ¢ __attribukte_ {{ab{0x19C)));

SpecifiedRange: Specified RAM range
Type and TypeLength: Variable type and type length. If it is a basic type, the type length cannot

be changed.

Name represents the variable name which can be an array.
The added variables can be re-edited by double clicking the variable list.

8) Specified Bank Vari

able

To generate specified bank variables. It automatically distributes the variables in the specified

range according to the variable length.

Specified Bank Variable
MCU:  HTGEFS0

-

Typelength: |2

Byte  Mame: € Bank: 0x280~0xzFF

Length

Variable Mame  Bank -

]

ra

Type: int -
Variable Type Type
char 1
shart z
float 3
double* 2
ink =

Code:

static volatile char a __ attribute_ {{at{0x8001);
static volatile short b attribute_ {{ak(0x1800));
static volatile Float c[5] __attribute_ {{at{0x18270);
static volatile double® d _ attribube_ {{at(0x1910));
static volatile int e __attribute_ {{at{0x28000);

MCU: MCU name

Type and TypeLength: Variable type and type length. If it is a basic type, the type length cannot

be changed.

Name represents the variable name which can be an array.

Bank: The specified

Bank

The added variables can be re-edited by double clicking the variable list.
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e CopyCode
To copy the generated codes.
* GenCode
To generated codes.
* Language
To select the user interface language.
Editor
Voice ROM Editor

The company provides a VROM Editor for the user to arrange the voice code for the specific MCU.
(eg. The HTS86 series)

HT-iwTool - [ht56r264TP] = = |==

Froject EBuild Help

New Open Save Build Down Excit
Project Project Project u load =
MCU Body [HTseRzE JBa |

Flash Size 128K Bytes =~ Systermn Frequency |4000KHz -

99.792% free : 130800 (1FEFOh) bytes
Source File {Moice/Data)

Encode Type (Wayv) [HT-aDPCM - +| -] I =

Mo, | File Mame |T\,rpe | Mode | Mickname |

Fig 3-13
Data Editor

Some the company MCUs (eg. the HT48E series) include internal EEPROM memory. The Data
EEPROM Editor provides an interface for the user to arrange the data and download/upload the data
to/from the ICE.

Rev. 1.30 27 May 09, 2022



HDLTEK#

HT-IDE3000 User’s Guide

7| Data Editor

File:  Cillzershobek\Documents\HTE_ProjectHTEEF SOMHTEEFS0 ME

ADDR 0 1 2 3 4 5 &

pooo:[§F FF FF FF FF FF FF ...
goo?: FF FF FF FF FF FF FF ...
000E: FF FF FF FF FF FF FF . ..
001%: FF FF FF FF FF FF FF ...
00lc: FF FF FF FF FF FF FF . ..
002z FF FF FF FF FF FF FF . ..
0024: FF FF FF FF FF FF FF . ..
0031: FF FF FF FF FF FF FF . ..
003e: FF FF FF FF FF FF FF . ..
003F: FF FF FF FF FF FF FF . ..
004t : FF FF FF FF FF FF FF . ..
o004l FF FF FF FF FF FF FF ...
on0s4: FF FF FF FF FF FF FF ...
O0SE: FF FF FF FF FF FF FF ...
oo0e2: FF FF FF FF FF FF FF ...
o0e%: FF FF FF FF FF FF FF ...
oo?0: FF FF FF FF FF FF FF ...
ooy??: FF FF FF FF FF FF FF ...
007E: F¥F FF FF FF FF FF FF . ..
00ss: FF FF FF FF FF FF FF . ..
ooscC: FF FF FF FF FF FF FF . ..
009z FF FF FF FF FF FF FF . ..
00%4: FF FF FF FF FF FF FF . ..
0041: FF FF FF FF FF FF FF . ..
004 FF FF FF FF FF FF FF . ..
00AF: FF FF FF FF FF FF FF . ..
00B&t: FF FF FF FF FF FF FF . ..
O00ED: FF FF FF FF FF FF FF . ..
ooc4: FF FF FF FF FF FF FF . ..
00CE: FF FF FF FF FF FF FF . ..

AT . T

Ce Upload

Exit

m

'EJ‘ VDownload

Body

HTS3F10

File

File Path  C:\USERSVHOLTEKA\DOCUMENTS

File Size 131074

[ Download with Werify

Download |‘ Upload

Fig 3-15

Bytes
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LCD Simulator

The LCD simulator, LCDS, provides a mechanism to simulate the output of the LCD driver.
According to the designed patterns and the control programs, the LCDS displays the patterns on
the screen in real time. LCD Simulator only supports part of MCUs based on the ICE architecture.
Additionally, this part is no longer being updated.

Voice & Flash Download

The Voice & Flash Download downloads the contents of a specified voice data file with the
extension .VOC or .DAT to the ICE for emulation or burn the voice data to SPI Flash by e-Writer. It
also uploads from ICE VROM or SPI Flash saving the data to a specified .VOC or .DAT file. Fig 3-15
displays the dialog box which shows the name of the download voice .VOC, which was generated
by the VROM editor. The File Size box, below the File Path box, displays the voice ROM size in
bytes for microcontroller device in the current project. Ensure that the voice file .VOC has been
generated by the VROM editor before downloading.

Switch OCDS Mode

This command is only used for OCDS-ICE, two modes can be selected here and correspond to
different package types respectively. (Fig 3-16)

| 0CDS Mode =
(1oChs

@Ic

| wE | | A

Fig 3-16

Smart Programming Settings

This function is available for OTP and MTP type MCUs.
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Smart Programming @

Programming Setting

Check ID Current MCLU: HT42EDG

Erase Blank Check

Blank Check

Program
Werify
User Specified Data (USD)

Lock

Dperation Setting

Prograrm (@ all Range | Select... User Specified Data
Option @ all Setting
Data @ All Range | Select...
Voice Al Range | Select...
Fig 3-17

This function refers to Chapter four in the HOPE3000 documentation.

In Circuit Programming
If the MCU is Flash type and the Bootloader function is unavailable, an ICP function is provided to
be used for programming the MCU.

[1cP e

Press "Start" key to program

Programming Yoltage

i@ 5V & 3v

Power On Power Off

—~

* Programming Voltage
There are two voltages with the values of 3V and 5V respectively which can be used as the
programming voltage. For MCUs that can only be programmed at a fixed voltage, the correct
voltage option will be checked automatically with the unavailable voltage being masked.

e Start
Start to program. After the programming is completed, the MCU will be locked.

* Power On
Only when the programming has been successfully executed, the button will be enabled. It will
be powered on at the selected programming voltage.
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» Power Off
Only when the programming has been successfully executed, the button will be enabled.

e Quit
Quit the ICP programming.
Options Menu

The Options menu (Fig 3-18) provides the following commands which can set the working
parameters for other menus and commands.

HT-IDE3000 - C:\Users\holtek\Documents\HTK_Project\HT48E06\HT48E06. pjtx o)==
File Edit View Project Buid Debug Took | Options | Window Help

D@ +BB 22> 0RE Project Settings - .

& g EL D & Editor Settings =
— Language 3

TURER I VRS- iy

0P8 a2 &g

Lnl1,Coll DISCONNECT Emmlstion PC=2424H Resst 0"

Fig 3-18

Project Settings
Project Option
The Project Option sets the default parameters used by the Build command in the Project menu.
During development, the project options may be changed according to the needs of the application.
According to the options set, the HT-IDE3000 will generate a proper task file for these options
when the Build command of the Project menu is issued. The dialog box (Fig 3-19) is used to set the
Project options.

Project settings @

Froject Option | Debug Option | Directories | Document | Production

ticro Controller HTEEFESSD
Language Tool:
Haltek C Compiler W3 A sembler v] ’ Build Option. .. ] [ISF' Bootioader O ptior

Agzembler/Compiler Dptions
Define Symbal W3
Generate izting file Generate Project hzting filelist)

Linker Dptions

Libraries Browse

Section address
Generate Map File

|JSE FIFO Size: 0 Bytes[Decimal]

Ok ] [ Cancel

Fig 3-19
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Bootloader Option @

[7]Use 15 Bootloader [StartatIsPmede v | M: 0 =]

[ Bootioader ¥ID/PID Cption |

[T Use the Custom Bootloader

Browse

[ ik ] [ Cancel ]

Bootloader WID/PID Option 3w
(@) Use Holtek Bootloader  ID:04D9  PID:E02Z
(7 Use the Custom Bootloader YIDYPID

VID FID

QK l [ Cancel

Fig 3-20

Note: Before issuing the Build command, ensure that the project options are set correctly.

e Micro Controller

The chosen MCU for this project is selected here. Use the scroll arrow to browse the available

MCUs and select the appropriate one.

» ISP Bootloader Option
When clicking on the botton, the configuration dialog box (Fig 3-20) will be displayed.

*

*

¢

This function is available for the USB Flash MCU series only.

To use ISP programming, first check the “Use ISP BooLoader” option and then select the first
executed program section after power on.

Start at ISP mode — After power on, the program will firstly run the Bootloader code to wait
for the AP to start the USB Link. After completing the update, the program will jump to the
user code.

Start at User mode — After power on, the program will firstly run the User code. If a program
update is required, the program will call the Library to return to the BootLoader code for
updating. After completing the update, the program will jump to the User code once again.

ID Selection — For identifying different devices with the same bootloader.

Bootloader VID/PID Option — This function is to select whether to use the Holtek Bootloader
or touse the Custom Bootloader VID/PID

Use the Custom Bootloader — Allows users can load the custom bootloader mtp file.

* Project’s Build Option

Clicking on the button will cause the configuration dialog box to be displayed. This is used to set

the Complier options.

» Language Tools
Includes the Holtek C compiler V1, Holtek C compiler V2 and Holtek C compiler V3. It is
recommended to use the V3 version which provides a program optimisation function.
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* USB FIFO
Setup the USB FIFO size.

* Assembler/Compiler Options
The command line options of the Cross Assembler. Define symbol allows users to define values
for specified symbols used in assembly programs. The syntax is as follows:

symboll[=valuel] [,symbol2 [=value2] [,...]]
For example:
debugflag=l, newver=3
The check box of the Generate listing file is used to check if the source program listing file has
been generated.
Additionally, users can click the Generate Project listing file to generate the disassembling record
file (.list) saved in the the Project directory.

» Linker options
To specify the options of the Cross Linker. Libraries are used to specify the library files refered
by Cross Linker.For example:
libfilel, 1libfile2
Library files can be selected by clicking the Browse button.
Section address is used to set the ROM/RAM addresses of the specified sections, for example:

codesec=100, datasec=40
The check box of the Generate map file is used to check if the map file of Cross Linker is

generated.
Debug Command

This command sets the options used by the Debug menu. The dialog box (Fig 3-21) lists all the
debug options with check boxes. By selecting the options and pressing the OK button, the Debug
menu can then obtain these options during the debugging process.

Project settings @

Project Option | Debug Option | Directories | Document | Production

Trace Record Fields Auto Stepping Command

pragrarm caunter [PC] G Step Inta

machine code [CODE] ) Step Dver
deassemnbled instruction (INSTR] Stack

execution data [DATA] Detect Stack Overflow

file, line number [FILE-LIMNE]

Cannection Part
zource line [SOURCE]

@ LPT1 e CE
LPTZ2 e-Link.
USBZLPT M are

General
Dizplay variable value when debugging
[] Hexadecimal display
Download EEPROM data
Fiun ko main(] after build

0K ] [ Cancel

Fig 3-21

Rev. 1.30

33 May 09, 2022



HDLTEK# HT-IDE3000 User’s Guide

Trace Record Fields

This location specifies the information to be displayed when issuing the Trace List command,
contained within the Window menu. For each source file instruction, the information will be
displayed in the same order as that of the items in the dialog box, from top to the bottom. If no
item has been selected, the next selected item will be moved forward. The default trace list will
display the file name and line number only. The de-assembled instruction is obtained from the
machine code, and the source line is obtained from the source file.

General

Several items are used to display certain actions when in the debug mode, such as displaying
variable values, hexadecimal displays and downloading EEPROM data. The Download
EEPROM data check box is only checked when the selected IC has an EEPROM function. If the
check box is checked, the EEPROM will be downloaded to the hardware simulator automatically
when executing the Build command.

Auto Stepping Command
Selects the automatic call procedure step option, namely Step Into or Step Over. Only one option
can be selected.

Stack
Uncheck this Detect Stack Overflow box if you do not want the system to show a message while
detecting a stack overflow.

Connection Port
Display the PC connection port for the ICE. The connection port has no effect if the simulation
mode is selected.

Directories Command

The command sets the default search path and directories for saving files. (Fig 3-22)

. Project settings @

| Project Option | Debug Dptionl Directaries | Document | F'rol:luctionl

Output filez path:

JocurnentssHTE, ProjecthHTEEFBEE0 E]

Show directaries for;

Include paths -

Directories: R O I 2
C:A\Program FileshHoltek MCU Developrment Tools\HT-IDE 300007 w\MCLUDE W3

[ OF. J [ Cancel

Fig 3-22
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* Include paths
The search path referred to by the Cross Assembler to search for the included files.

 Library paths
The search path referred to by the Cross Linker to search for the library files.

* Output files path
The directory for saving the output files of the Cross Assembler (.obj, .Ist) and Cross Linker (.tsk,
.map, .dbg)

Document

This command is used to add documents to the project. When documents are added, they will be

listed on the Documents window on the left hand side as shown in Fig 3-25.

Project settings @
Project Option I Debug Option I Directonies | Document | Production
...... r ¥+
Title Fath
ak. ] [ Cancel
Fig 3-23
Project settings =3
| Froject Option I Debug Elptionl Directonies | Document | Production
N U S 2
Title Path |
Add / Change Book Item (=3
Book Title:
help
Eook Path:

AL L A Program FilestHoltek MCU Development ToolsiHT-IDERDOOYT . x|

[ Ok ] [ Cancel ]

Ok ] [ Cancel

Fig 3-24
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=429 Tools User's Guide

@ Holtek HT-IDE2000 &User’
@ Holtek C WV1(HCC) Prograr
@ Holtek C V2{EHCC) Progra
- Holtek CV3{HGCC) Progr:
- Holtek C V1{HCC) In Com
@ Holtek C standard library v
- Holtek e-ICE Quick Start
@ Holtek e-ICE Pin Assignme
@ Holtek HTEOCDS-ICE User
@ Holtek C WV3(HGCC) FAQ
=-4=9 Device Data Documents

Production

In order to let users know which IC has been locked, the HT-IDE3000 provides an identification
code function as shown in Fig 3-26.

When the setput is finished, the identification code will be written into the corresponding document
(OTP, MTP, PND) by clicking on the ReBuild All button.
Note: This function is available for OTP and flash type MCUs

The HT-IDE3000 software version must be 7.71 or above

The HOPE3000 software version must be 3.06 or above

Project settings @
| Project Dptionl Debug Option | Directaries | Document | Production |
Enable identification code
||*** [Enter up to 3 characterz)
Ok ] ’ Cancel
Fig 3-26

Editor Settings
Format
This command is used to set the foreground and background colours.From the available options,

shown in Fig 3-27, Text Selection is used for the Edit menu, Current line, Breakpoint Line, Trace
Line and Stack Line are for the Debug menu and Error line is for the Assembler output.
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Editor settings @
Format | E ditars

Category: Font: Size
(=S| [Finedsys - 12z -

Te=t Selection
Current Line
Enkainn_a L Foreground: B ackground:
reakpoink Line
] | =
Stack Line
Selection kMargin
Foeywaord
Cormment
Humber
String

R eseat All

Colars

Sample

Sc':lITIP]_E'

[ Ok ] [ Cancel ] Apply

Fig 3-27
Editors

This command is used to set the editor options such as tab size, the Undo command count and some
functions’ disable settings. The Save Before Assemble option will save the file before assembly.
The automatic reload of extemally modified files will load the files automatically which have been
modified externally. The Disable Classview option will not display any information on the classview
window. The Disable Suggestions list is disable variable tip list. The Disable Suggestions Tip is used
to disable the function parameters tip.

o )

Editor settings @
Editors

Tab optionz
Tab size: i) Inzert spaces
@ Keep tabs

Auto Indent

Save option
S awe before running toolz

[] Automatic reload of externally modified files

[] Dizable Clazsview
["] Disable Suggestions List [ Digable Suggestions Tip

[ ] 4 ] [ Cancel Apply

Fig 3-28
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Language
This command changes the language of the user interface. ‘Default’ is the language of the operation
system.

Customise
This command can rearrange and modify the toolbar buttons, menu and menu commands. Users can
customise the toolbars according to their own preferences.

e-Link Activation
The e-link must be registered when first used. Click on the About HT-IDE3000 options in the Help
menu and a dialog box will be displayed as shown:

About HT-IDE3000.., ==
Holtek Integrated Development Environmerit [ Ok ]
Wersion: 7.83 lUpdate Firmware]

Date: 2016M1/23

[ Regizter e-Link J

CCDS-ICE Fane 0110 100300 YER: 03 ID-CODE: 43543512 PID:S00C

Copyright (C) 2005-2016 Holtek Semiconductor Inc.

Additional Information:
“oice Template:
Yersion: 01
Build Date: 20104112

Holtek WYWebsite:
httpedtaeaens holtel com.

Address:
MZU Tool Development Dept.
Mo.3 Creation Rd.ll,
Science-based Industrial Park,
Hzinchu, Taivwan, R.O.C.

Fig 3-29

Click on the Register e-Link button and a dialog box will be displayed as follows:
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Enter the registration code to active e-Link...

e-Link Type Holtek 8-Bits MCU ¢

e-Link ID 0012-0014-7072-1329-9809

Registration Code |

Mo Registration Code?

If your e-Link is not registered before, please click
below button to register to get a registration code

Register Now!

Click here to register from web...

Fig 3-30

Click on the Register Now button, a dialog box will be displayed as follows:

Registration Sheet @
e-Link Type Holtek 8-Bits MCL OCDS
e-Link 1D 0100 - 1021 - B93g
0225 - 4164
E-mail(*) |
First name
Last Mame
Company
Country
City
Purchase Date  2018/12/12 @~
Fig 3-31
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Fill out the register information. The e-Mail field is required, the others are optional fields. After
filling out the fields, click on the Register button and you will receive an e-mail in your mailbox
after a short time. The message header is e-Writer Pro Registry Key. Fill in the Registration Code
field and click on the Active button. The following message will be displayed which represent a
successful register process.

eLinkIap

i I: Fegister success!

] 4

Fig 3-32
If the registration process is blocked by either anti-virus or firewall software then the registration can
be done on-line.

Click on the hyperlink “Click here to register from web...”

e =3 a Ch\Program Files\Holte O ~ & & Holtek Semicanducto... X f Xk

HOLTEK SEMICONDUCTOR INC,
English R SiEHN

Register

Type: |e-Link |

*

=
2

: [0012-0014-7072-1329-950|

* E-mail: | |

First Name:

Last Name:

Company:

Country: | |

City: | |

Purchase Date:

Type and ID values will be automatically generated. Data in the other fields should be filled in by
the user, with email contact information being a compulsory requirement.
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Bookmarks

The Bookmark window is a useful companion tool for the Code Editor. Lines in the user code can be
marked with bookmarks. This enables the user to open files and navigate directly to the lines marked
simply by double- clicking entries in the Bookmark window.

Bookmarks Window

The Bookmark window can be selected from the Window meu

Bookmar ks File location Line number
[¥](_) Untitled C:\Usersiholtek\Documents\HTK_Project 7
Fig3-33
Bookmarks

Displays the name of the bookmark. Default names are created as Untitled. Custom bookmark
names can be created by double-clicking on the bookmark name entry.

Each bookmark has its own check box. To activate an existing bookmark, select its check box in
the Bookmarks window. To hide, but not remove, an existing bookmark, clear its check box in the
Bookmarks window.

File Location

Lists the fully qualified path for the file.

Line Number

Lists the line code numbers where the bookmarks are located.

Tip: Double clicking on the file location or line number will open the file and navigate directly to the
marked lines.

Bookmark Window Toolba

002EB @,
Fig3-34
Toolbars from left to right are:

» Toggle a bookmark on the current line
Adds or removes a bookmark on the selected line of the document in the active Editor. Does not
alter the code line bookmarked.

* Move the indicator to the previous bookmark
Selects the previous enabled bookmark in the Bookmark window. When the first bookmark is
reached, it jumps ahead to the last one. As required, it opens the file where the selected bookmark
occurs in the Editor. Scrolls that document to the bookmarked line and places the insertion point
there.

* Move the indicator to the next bookmark
Selects the next bookmark that is enabled in the Bookmark window. When the last bookmark is
reached, it jumps back to the first one. As required, it opens the file where the selected bookmark
occurs in the Editor. Scrolls that document to the bookmarked line, and places the insertion point
there.
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* Move the indicator to the previous bookmark in the current file

Selects the previous bookmark that is enabled within the current file in the Bookmark window.
When the first bookmark is reached, it jumps ahead to the last one in the current file. As required,
it opens the file where the selected bookmark occurs in the Editor. Scrolls that document to the
bookmarked line, and places the insertion point there.

Move the indicator to the next bookmark in the current folder

Selects the next bookmark that is enabled within the current file in the Bookmark window. When
the last bookmark is reached, it jumps back to the first one in the current file. As required, it
opens the file where the selected bookmark occurs in the Editor. Scrolls that document to the
bookmarked line, and places the insertion point there.

Clear all bookmarks
Clears all bookmarks in the Bookmarks window. Does not alter the bookmarked line code.

Bookmark Menu

In addition to using the Bookmarks in the Toolbar, the same operation can be executed using the
Bookmarks Menu.

The menu can be found in the edit drop-down men

() Togele Bookmark Chl+F2
&) Previous Bookmark “hift4F2
Q Next Bookmark F2
45| Previous Bookmark In Docurment
[E.  Next Bookmark In Document

@ Clear Bookmarks CltEhift+F2

Fig 3-35
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Chapter 4 Menu - Project & Build

The HT-IDE3000 provides an example Project, which will assist first time users in quickly
familiarizing themselves with project development. It should be noted that from the standpoint of the
HT-IDE3000 system, a working unit is a project with each user application described by a unique

project.

When developing an HT-IDE3000 application for the first time, the development steps, as described
earlier, are recommended.

HT-IDE3000 - CUserssholtekyDacurments\HTK_PrajectyHTEFESS0NHTE6FESS0, pjt - [HTG6FESS0.c]

Project | Budld  Debug  Tools Options  Window Help
M

B Fle Edit View
D@ &
& ) g =L G
LA L2
0LE &EE

" Project: HTG6FB
LG MCU: HT6BR
LI Source Files
L.[g] HTE6FES
LI Startup Cod

New

Open...

Edit

Save

Save to ¥6 Project (htt6Bib550 pri)
Close

File location

C:\Usersyholtek\Documents\HTK_Projec

JLinE number
7

Option Table Fiewer
Backup/Restore Project »
Recent Projects >

-B startupllasm
1 OBJFiles

<

I,

| J Wark

3 Class QDncu

=] Cutput | Gy Find in Filss | S Wetchl | Bl Watch? | Bl Watch3 | Bl Watchd | 5] At | ELocal | | Bookmarks

Create a New Project

Azzemible

My
.

Build

CodeWizard flowchart

Project Location

Project Option

Rebuild All

Lnf, Coll

Fig 4-1

U

T T T T T T T 7]

Project Deployment

Configuration Options

Project Settings

Finish

DISCONNECT Emulation PC<XEXEH

Fig 4-2

Note: The project name is a file name with the extension .PJT and .PJTX.

Use Voice template

. Finish

In the Project menu (Fig 4-1), select the New command to create a new project. This command will
call the CodeWizard to assist users to create a new project.
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Step1: Project Location
This step will require the user to input a project name and a file path — see Fig 4-3. Users can access
all of the data and already existing projects to select an already existing project, or can instead input
a new project name. Additionally, users can select the required microcontroller for their project
and the lauguage tools. For some certain MCUs, a BootLoader option is available and this option
provides an [AP function — see Fig 4-4.

Project Location - Stepl @

Froject Hame :

Project Location

C:\Usershhdmini strator\Document shHTE_Froject E]
Project MCU Create directory for proje
BC48ER2020 - .

MCT Information

with Boot Loads Bl Size: 1 Bank (=)
Choose Language Tool Il S L
= Stack 2

[]‘[nltek C Compiler VZ (EHCC)/h=zsemb w

BootLoader OH
More project settings

< Baclk (B [Hext (1 >] [ Cancel ]
Fig 4-3
Project Location - Stepl @

Project NHame :
Project Location
C:\UsershhdministratoriDocumentshHTE Froject E]
Froject MCU Create directory for proje
HIEEFESS0 - .

MCU Information
with Boot Loadi |Start at ISF mo - EAM Size: 6 Bank(s)

EOM Size: 2000H
Chooze Language Togyot at User mode HEE

= Stack g

[]‘[nltek C Compiler ¥3fhssembler v]

BootLoader 200H
Mu:-re project settings

¢ Back (B) [Hext (H1 >] [ Cancel

Fig 4-4
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Step2: Project Option
The second step is to select whether assembly files or C-language files are to be used in the project.

Project Option - Step? @

Create a source file to add to your
Choose the file type to create

1. ASH
G COV3C compiler FAQ )

[<Back (B ][Hext [ >] [ Cancel ]

Fig 4-5

Step3: Project Deployment
This step is to change the source program File name, program section and data section.

Project Deployment - Step3 @
Codeffiz creates the following items for wou

File name : Header file :

HIEEFESSO. h

DImpnrt configuration options from other project

[< Back (E] ][Hext (H) >] [ Cancal

Fig 4-6

And finally is the Configuration Option and Project Setting operations. For this consult the related
chapters.
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Open and Close a Project

The HT-IDE3000 can work with only one project at a time, which is the opening project, at any time.
If a project is to be worked upon, the project should first be opened, by using the Open command
of the Project menu (Fig 4-1). Then, insert the project name directly or browse the directories and
select a project name. Use the Close command to close the project.

Note: When opening a project, the current project is closed automatically. Within the development
period, i.e. during editing, setting options and debugging etc., ensure that the project is in the
open state. This is shown by the displaying of the project name of the opening project on the
title of the HT-IDE3000 window. Otherwise, the results are unpredictable. The HT-IDE3000
will retain the opening project information if the system exits from the HT-IDE3000 without
closing the opening project. This project will be opened automatically the next time the HT-
IDE3000 is run.

Manage the Source Files of a Project

Use the Edit command to add or remove source program files from the opened project. The order,
from top to bottom, of each source file in the list box, is the order of the input files to the Cross
Linker. The Cross Linker processes the input files according to the order of these files in the box.
Two buttons, namely [Move Up] and [Move Down], can be used to adjust the order of a source file
in the project. Fig 4-7 is the dialog box of the Project menu's Edit command.

Project Edit 23]
Lookin: || HTGEFBSS0 - @ > E
T Marme ° Date modified Type
e | BACKUP 2016/12/9 T 01 File folder
RecentPlaces |\ ireerpssi.c 2016/12/8 T 12..  CFile
! || startupl_lasm 2016/8/24 E5F 03, AIM File
Desktop
Libraries
A
Computer
@
“ 1| n 3
Metwork
File narme: - Add
Files af type: Source Files [*.asm;".as.".c] v] [ Cancel ]

Files in project:
Ccl \holtek\Documents\HTK. Project\HTEEF BAS0WHTEEFBES50. ¢
Ik
s Yholtek\Documents'\HTK, Project'HTEEF BSSDstartupl | asm _
Wawe Down

Fig 4-7
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To Add a Source File to the Project
Choose a source file name from the file list box. Double-click the selected file name or choose the
Add button to add the source files to the project. When the selected source file has been added, This
file name is displayed on the list box of the Files in project.

To Delete a Source File from the Project
» Choose the file to be deleted from the project

e Click the Delete button

Note: Deleting the source files from the project does not actually delete the file but refers to the
removal of the file information from the project.

To Move a Source File Up or Down
* Choose the file to be moved in the list box (Files in project), by moving the cursor to this file and
clicking the mouse button

* Click the [Move Up] button or the [Move Down] button

Build a Project’s Task Files
Be sure that the following tasks have been completed before building a new project:
* The project has been opened
* The project options have all been set
» The project source files have been added
» The MCU options have been set (refer to the Tools menu chapter)
There are two commands related to the building of a project file, the Build command and the
Rebuild all command.
The Project menu’s Build command performs the following operations:

» Assemble or compile all the source files of the current project, by calling the Cross Assembler or
C compiler depends on the file extension .asm or .C

+ Link all the object files generated by the Cross Assembler or C compiler, and generate a task file
and a debugging file.

* Load the task file into the ICE if it is powered-on

 Display the source program of the execution entry point on the active window (the HT-IDE3000
refers to the source files, the task file and the debugging file for emulation)

Note: The Build command may or may not execute the above tasks as the execution is dependent on

the creation date/time of all corresponding files. The rules are:

 If the creation date/time of a source file is later than that of its object file, then the Cross
Assembler or C compiler is called to assemble, compile this source file and to generate a new
object file.

 If one of the tasks object files has a later creation date/time than that of the task file, then the
Cross Linker is called to link all object files of this task and to generate a new task file.

The Build command downloads the task file into the ICE automatically whether there is an action or

not.

The Rebuild All command carries out the same task as the Build command. The difference is that
the Rebuild All command will execute the task immediately without first checking the creation date/
time of the project files.
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The result message of executing a Build or Rebuild All command are displayed on the Output
window. If an error occurs in the processing procedure, the actions following it are skipped, and no
task file is generated, and no download is performed.

To Build a Project Task File
* Click the Open command of the Project menu to open the project
* Click either the Build command of the Build menu or the Build button on the toolbar (Fig 4-1) to
start building a project

To Rebuild a Project Task File
* Click the Open command of the Project menu to open the project
* Click either the Rebuild All command of the Project menu or the Rebuild all button
On the toolbar (Fig 4-1) to start building a project once the project task has been built successfully,
emulation and debugging of the application program can begin (refer to the HT-IDE3000 menu -
Debug chapter).

Assemble/Compile

To verify the integrity of application programs, this command can be used to assemble or compile
the source code and display the result message in the Output window.

To Assemble or Compile a Program
+ Use the File menu to open the source program file to be assembled or compiled

« Either select the Assemble/Compile command of the Build menu or click the Assemble button on
the toolbar to assemble/compile this program file

If the opened file has an .asm file extension name, the Cross Assembler will execute the assembly

process. If the file has a .C extension then the C compiler will compile the program.

If no errors are detected, an object file with extension .OBJ is generated and stored in the directory
which is specified in the Output Files Path (refer to Options menu, Directories command). If an
error occurs and a corresponding message displayed on the Output window, one of the following

commands can be used to move the cursor to the error line:

* Double-click the left button of the mouse or Select the error message line on the Output window,
and press the <Enter> key

Print Option Table Command

This command is used to view and check the files (otp, mtp, pnd, cod) in the project (Fig 4-8). The
Browse button is used to open the files. The Print button is used to print the current active option
file to the specified printer. The printer may be selected when the option file is to be printed out. It is
recommended to use a different printer port from the port which is connected to the ICE.
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Backup/Restore Project

| & Option Uiewer

=

File|D:\Prnjects\FanTEStEude\nDDn_DB_FnH.MTP Browse | | Print |

MCU Hame
File Hame
HT-IDE Ver.
Compiler Ver.
Linker Uer.
CFG Ver.

MTP Code File

Product Hame :

: HTASFM3B@

: D:\PROJECTS\FANTESTCODENADDA_DC_FAN.HMTP
L L |

: HCC2.08

HELLE

U119

Checksum = [ 2COOH ]

Program Code Ghecksum : [ DSBCH ]
MTP Code Checksum:[ 157CH ](Program code checksum+Option code checksum+Data code

Fig 4-8

If both the printer and the ICE are using the same printer port, issuing this command will cause the

loss of all debug information and corresponding data. After the printing job has finished, the user

should proceed to the very beginning of the development procedure and use the Build command of

the Project menu if further emulation/debugging of the application program is required.

The Backup Project command will use PROJECT DATE_ VERSION format to compress the
current project, and also allow users to add some project description in [Description] editing box if

necessary.

The Restroe Project command will restore the compressed project which selected in the backup list

box currently.
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Chapter 5 Menu — Debug

In the development process, the repeated modification and testing of source programs is an
inevitable procedure. The HT-IDE3000 provides many tools not only to facilitate the debugging
work, but also to reduce the development time. Included are functions such as single stepping,
symbolic breakpoints, automatic single stepping, trace trigger conditions, etc.

After the application program has been successfully constructed, (refer to the chapter on Build a
project’s task files) the first execution line of the source program is displayed and highlighted in the
active window (Fig 5-1). The HT-IDE3000 is now ready to accept and execute the debug commands.

HT-IDE3000 - C:\Users\Administrater\Documents\HTK ProjectESK-F/160-100-KEY- TEST\HTE6F/160 VoiceLibrarypjt: - [HTEEF/160 Test.asm] =0 = ===
B File Edit View Project Build Debug Tools Options findew Help - @x
DEH@ & BB oo MR & 5 - 4 w P
SEEED @

BB A4 T
0P8 @
259 ROR x
AR x
ject: HTBEFY160_VoiceLibrary (%) g:f _HEY_SCAN ENDP e — I: pPC CODE  INSTRUC
MCU: HTEEFV160 e fddress: (] 5 B
| : i ADDFD 1 2 3 .|| apDR O 1 2 i
Source Files 248 : ey fuction ADDEC i o on 0000: @9ee 00T @gce @[ |
HTGEFV160_Testasm 2uly oo 940 @3 @@ 00 0010 @000 @000 00T @
N N . 245 _KEY DO PROC 55 60 60 6@ 08 0020 €@E0 GE0D @9EE @
Voice Library_Choice.asm 246 i 5C. 00 @7 9@ G@ 0030 @200 @9QE @00 @
<o |2 ||| D040 @eee @ese eeee @

Startup Code 247 Hou A, KEY_UALUE J0:30 gp @8 28 -+ % | 0050 wece soso osco o
081 Files 248 XOR A, 010 e oo oa 0e 0DE0: GO0 AIG0 960 @

Header Fles 249 sz 2 i ge e oo oe 0070: @@0¢ D999 @900 @

. 258 Jnp DO_UOLUME_DOWN | A0° @@ 0@ @@ oo Ld|| 0080 @800 G900 €000 @

External Files . -0 - 21 66 60 o 06 0050 @@ge @EoD @aee @
HTBEFVLE0INC 252 Hou A, KEY_UALUE 4500 G0 68 @0 0080 Ga00 @osa eace o

e AC 00 @0 @0 08
HTE6FV160 HED 253 XOR A, 020 20. 08 0 96 90 00C0- @EQ 0EID @9ee @
255 sz 2 TG ot om0 00D0: @80 @00 @960 @
0DEQ: @960 @30 9900
255 Jnp _DO_UOLUME_UP 58 00 00 @@ 60 D050 Ba0e Bees oeas 0
256 Do go o oo e 0100 G00F @000 G00T @
i i VIl C0- Qe @@ a2 e <[ 0710 oeee eeoo @ese @ i
e o W < b b “RANO {RMNL {RM2 | < [0 3 L
Work. .. SgClas Docu. . 4 HIGEFY160_Test. asm X HTEEFY. gaStack | WgTrace G Disasz.
) (= 5

Ready Ln 246, Col 5 USB Emulation PC=00DIK Resel OVE CAP NUM SCEL

Fig 5-1

Reset the HT-IDE3000 System
There are 4 kinds of reset methods in the HT-IDE3000 system:
» Power-on reset (POR) by plugging in the power adapter or pressing the reset button on the ICE
* Reset from the target board
* Software reset command in the HT-IDE3000 Debug menu (Fig 5-2)
» Software power-on reset command in the HT-IDE3000 Debug menu (Fig 5-2)

HT-IDE3000 - CaUserstAdministratoriDocumentsiHTK Project\ESK-Fu/160-100-KEY- TEST\HTG6F/160_Voicelibrary.pjbc - [HT66FV160_Test.asm] =0 E=R===)|
[B) File Edit View Eroject Build |Debug | Teols Optisns Windew Help _a@x
DEHE e oo EEe | o P
B L @ - H{} Bun to Curser T -

= Tunp to Cursor
BRGN £L 0
Stop Debugging
088 a5 G-
e 0 | ster KLtHFS
240 Trace Stop x | Bom X
liect: HT66F/160 VaiceLibrany (3| 5,0 T . I: pC CODE  INSTRUC
MCU: HTBEFVIE0 e B Step Into F5 8¢ colu ess: —_— -
) A step gver L||aDR 0 1 2 -
Source Files 243 | 0% Ster O L FAE 0000 ; 090T 9009 09ET @[
HT6GR/160 Testasm 244 | Step out i | 9o @@ @@ | 0010 0EEF @0RE COEE @
S ; 215 98 56 60 0020: 0G0@ @O0E CAAE @

Weice_Library_Choice.asm o Step Fl11 o oo o8 0030 AEER EEEE @IEE @

Startup Codh & ||| 0040 Geee sese ease @
artup Code 247 epping gg gg gg 0050 9900 @090 0EDE @

OB Files 248 s 0060 0860 @0F0 EOOE @

. & Beset F4 (06 06 00 0070. 090 @00T 0O@E @

Header Files 249 @@ 0@ @9 .. ..

959 |7 Poner on Reset @0 @8 03 | || 0080 aeee eese ewee @

Extornal Files S et 1 90 50 03 0050: AE0@ @O0E CAAE @
. gset Trace 0040 0O00 @000 EOOE @

HTBGFV160.NC 252 R 00B0: 480 @eA GOAE @

HT66FVLE0HED 253 Erealpoints. .. Cult | 9o oo oo 00C0. 9900 @000 EOOe @

254 | Traact/Bemre Breaigoint re |80 0 a0 D e Bams oame
ocg | % Renoves ALl Bredpoints Cerl4SKif4FY | @@ @@ @@ 00FD 0@eR @eoe Cede @
90 50 03 0100: AE0@ @00E CAAE @
« i will e rase e - || niin nese eeos eeee @ - il

i [ — = M ' RAND RAMZ | < [l ’ L — |

[Aork .. |[FFClas. .. |[@Docu q & 1 = = — T GhStack | BnTrace @Ebizass
Rl Monitor
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Fig 5-2
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Go Stepinto Step over Step Out Reset Poweron Reset

A w 4 ¥ 4 >
SEiE -0 &
v

Toggle Break Point  Clear Al Bresk Point ‘GO 0 cursor Stop

The effects of the above 4 types of reset are listed in table 5-1.

Power-On Target Software Software
Reset ltem Reset Board Reset Power-On
Reset Command Reset Command
Clear Registers *) ) @) *)
Clear Options Yes No No No
Clear PD, TO Yes No No Yes
PC Value (**) 0 0 0
Emulation Stop (**) No(***) Yes Yes
Check Stand-Alone Yes No No No
Table 5-1

Note: * Refer to the Data Book of the corresponding MCU for the effects of registers under the
different resets.

** The PC value is 0 and the emulation stops.
**%* If the reset is from the target board, the MCU will start emulating the application after the
reset is completed.
PC — Program Counter
PDF — Power Down Flag
TO — Time-out Flag
To Reset from the HT-IDE3000 Commands
 Either choose the Reset command from Debug menu or click the Reset button on the toolbar to
execute a software reset

 Either choose the Power-on Reset command from the Debug menu or click the Power-on Reset
button to execute a software power on reset

Emulation of Application Programs

After the application program has been successfully written, the Build or Rebuild command should
be executed to build the project files and download the programs to the hardware simulator. If
successful, the first executable line of the source program will be displayed and highlighted on the
active window (Fig 5-1). At this point, emulation of the application program can begin by using the
HT-IDE3000 debug commands.

Note: During emulation of an application program, the corresponding project has to be open.

To Emulate the Application Program

Choose the Go command from the Debug menu
* or press the hot key F5
* or press the Go button on the toolbar

Other windows can be activated during emulation. The HT-IDE3000 system will automatically stop
the emulation if a break condition is met. Otherwise, it will continue emulating until the end of the
application program. The Stop button on the toolbar is illuminated with a red color while the ICE is
in emulation. Pressing this button will stop the emulation process.
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To Stop Emulating the Application Program

There are three methods to stop the emulation, shown as follows:

 Set the breakpoints before starting the emulation

* Choose the Stop command of the Debug menu or press the hot key Alt+F5
 Press the Stop button on the toolbar

To Run the Application Program to a Line

The emulation may be stopped at a specified line when debugging a program. The following
methods provide this function. All instructions between the current point and the specified line
will be executed except the conditional skips. Note however that the program may not stop at the
specified line due to conditional jumps or other situations.

* Move the cursor to the stopped line (or highlight this line)

* Choose the Go to Cursor command of the Debug menu
+ or press the hot key F7
+ or press the Go to Cursor button on the toolbar

To Directly Jump to a Line of an Application Program

It is possible to jump directly to a line, if the result of executed instructions between the current
point and the specified line are not important. This command will not change the contents of Data
Memory, registers and status except for the Program Counter. The specified line is the next line to be
executed.

* Move the cursor to the appropriate line or highlight this line

* Choose Jump to Cursor command of the Debug menu

Single Step

The execution results of some instructions in the above section may be viewed and checked. It is
also possible to view the execution results one instruction at a time, i.e., in a step-by-step manner.
The HT-IDE3000 provides two step modes, namely manual mode and automatic mode.

In the manual mode, the HT-IDE3000 executes exactly one step command each time the single-
step command is executed. In the automatic mode, the HT-IDE3000 executes single step commands
continuously until the emulation stop command is issued, using the Stop command of the Debug
menu. In the automatic mode, all user specified breakpoints are discarded and the step rate can be
set from FAST, 0.5, 1, 2, 3, 4 to 5 seconds. There are 3 step commands, namely Step Into, Step Over
and Step Out.

* The Step Into command executes exactly one instruction at a time, however, it will enter the
procedure and stop at the first instruction of the procedure when it encounters a CALL procedure
instruction.

» The Step Over command executes exactly one instruction at a time, however upon encountering
a CALL procedure, will stop at the next instruction after the CALL instruction instead of entering
the procedure. All instructions of this procedure will have been executed and the register contents
and status may have changed.

* The Step Out command is only used when inside a procedure. It executes all instructions between
the current point and the RET instruction (including RET), and stops at the next instruction after
the CALL instruction.
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* To start Step Into
+ Choose the Step Into command from the Debug menu
+ or press the hot key F8
+ or press the Step Into button on the toolbar

+ To start Step Over
¢ Choose the Step Over command of the Debug menu
+ or press the hot key F10
+ or press the Step Over button on the toolbar

* To start Step Out
+ Choose the Step Out command of the Debug menu
+ or press the hot key Shift+F7
+ or press the Step Out button on the toolbar
Note: The Step Out command should only be used when the current pointer is within a procedure or

otherwise unpredictable results may happen.

If entering the automatic mode, first choosing the Debug option attribute page of the Project Settings
from the Options menu to set the two step commands, Step Into or Step Over in the automatic mode.

» To start automatic single step mode
Choose the Stepping command from the Debug menu also choose the stepping speed (the step
command is set in the Debug command from the Options menu)

* To end automatic single step mode
Choose the Stop command from the Debug menu

» To change automatic single step command for the automatic mode
+ Choose the Project Settings command from the Options menu
+ Choose the Step Into or the Step Over command in the Debug option attribute page of the
Project Settings dialog box

Breakpoints

The HT-IDE3000 provides a powerful breakpoint mechanism which accepts various forms of
conditioning including program address, source line number and symbolic breakpoint, etc

Breakpoint Features
The following are the main features of the HT-IDE3000 breakpoint mechanism:

* Any breakpoint will be recorded in the breakpoints list box after it is set, however this breakpoint
may not be immediately effective. It can be set to be effective later, as long as it is not deleted, i.e.
still in the breakpoints list box.

» Breakpoints of address or data, in binary form with don’t-care bits, are permitted.

* When an instruction is set to be an effective breakpoint, the ICE will stop at this instruction, but
will not execute it, i.e. this instruction will become the next one to be executed. Although an
instruction is an effective breakpoint, the ICE may not stop at this instruction due to execution
flow or conditional skips. If an effective breakpoint is in the Data Space (RAM), the instruction
that matches this conditional breakpoint data will always be executed. The ICE will stop at the

next instruction.

Note: 1. The ICE can only have a maximum of 3 breakpoints active at the same time, while e-ICE
can enjoy up to 65536 effective breakpoints.

2. It is acceptable to set breakpoints in Free Run mode for ICE, however, e-ICE is not.
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Description of Breakpoint Iltems

A breakpoint consists of the following descriptive items. It is not necessary to set all items, Fig 5-3:

Breakpoint IEI
Space ) Codde @ Data EEDistalE]
Location: WsersthottekDocumentstHTH_ProjectHTEEFBSS0HTEEFBISS0 o

7 To (7 Addrezz (@ “ariakle
cContent
[Clread [T write ¥ means don't care
A
Bl e Space Location Sonrce File Content Belio
CCDE 6 Aht66Eh550 ¢
CCDE i Aht66ib550.c Clear Al
| [Tl | 3
Evert
PC Orverflom Cyele Count Owverflow:
Stack Cwverflow: LR
Stack Underflow Wiakeup
Fig 5-3

Space
The location of the breakpoints, can be set in Program Code space, Data space or EEData space.

Location

For the actual location of the breakpoint, there are two different methods to comfirm the location:

Address and Line number.
Line number method:

* Input the file name which the location of the breakpoint belongs to. This file can be either a.C or
.ASM file. If there is no file name, then the current file will be taken as a default.

* Input the line number of the breakpoint:

HT-IDE3000 User’s Guide

For the ICE and e-ICE, multiple line settings are not allowed. They can only be set one line at
a time. Therefore only the first edit box is active and there is no need to input the second edit
box. For the e-Link, if setting one line, then the second edit box does not need to be filled out. If
setting multiple lines, the first line number and the last line number should be written in the two
edit boxes respectively.

In addition to the line number, the symbol name is also allowed to input to the first edit box.

When it is Code Space, the allowed symbols are as follows:

+ Label name. If programming in C language, the label name is a name in the .ASM file.

+ Section name

+ Procedure name, which is the function name. If programming in C language, the procedure
name is the name in the .ASM file.

When it is Data Space, the allowed symbols are as follows:

+ Dynamic data symbols defined in data section. If programming in C language, the name is a
name in the .ASM file and must be a global variable.
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¢ Address method:
— In this mode, only the address is needed.
— When it is Code Space, this address is an address in Program.
— When it is Data Space, this address is an address in RAM.
— When it is EEData Space, this address is EEPROM address.
Content

The data content of the breakpoint. This item is effective only when the Space is assigned to the
Data space. The Read and Write check box are used for the executing conditions of the breakpoint.
Breakpoints
The Breakpoints list box contains all the breakpoints that have been added, including the effective
breakpoints and non-effective breakpoints. The Add button should be used to add new breakpoints
to the list box and the Delete button is to remove breakpoints from the list box.
Event
Only the e-Link supports events. When the checked events occur, the e-Link will stop.
Note: The breakpoint in data space is only available for ICE but e-ICE.
» Format of Description Items — Location
The allowed formats of Location items are:
Absolute address (in code space or data space) with 4 format types, namely decimal, hexadecimal
(suffix with “H” or “h” or prefix with 0x), binary and don’t-care bits. For example
20, 14h, 0x14, 00010100b, 10xx0011
represents decimal 20, hexadecimal 14h/0x14, binary 00010100b and don’t-care bits 4 and 5
respectively.

Note: Don’t-care bits must be in binary format.
* Format of Description Items — Content

The content format has five digital number options, similar to the format of Location. These four
types of number are decimal, hexadecimal (suffix with “H” or “h”), binary and don’t-care bits.

How to Set Breakpoints

There are four methods to set/enable a breakpoint, one is by using the Breakpoint command from the

Debug menu, the others are by using the Toggle Breakpoint button on the toolbar, double clicking

on the gray bar in the edit window, or pressing key F9. The rules of the breakpoint mechanism are as

follows:

 Ifthe breakpoint to be set is not in the Breakpoints list box (Fig 5-3), then the descriptive items
must be designated first, then added to the Breakpoints list box.

* As long as the breakpoint exists in the list box, it can be made effective by Enabling the
breakpoint if it fails to be initially effective.

* Press the OK button for confirmation. Otherwise, all changes here will not be effective.

* When using the Toggle Breakpoint button on the toolbar, the cursor should first be moved to the
breakpoint line, and then the Toggle Breakpoint button pressed. If an effective breakpoint is to
be changed to a non-effective breakpoint, this can be achieved by merely pressing the Toggle
breakpoint button.

To Add a Breakpoint
* Choose the Breakpoint command from the Debug menu (or press the hot key Ctrl+B)
» A breakpoint dialog box is displayed (Fig 5-3)

» Designate the descriptive items of the breakpoint
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+ Set Space, Location items
+ Set Content item and Read/Write check box if Space is the data space

 Press the Add button to add this breakpoint to the Breakpoints list box.
* Press the OK button to confirm

Note: If the total count of the effective breakpoints is less than 3, the newly added one will take
effect automatically after it has been added.

To Delete a Breakpoint

* Choose the Breakpoint command from the Debug menu or press the hot key Ctrl+B
A breakpoint dialog box is displayed (Fig 5-3)

» Choose or highlight the breakpoint to be deleted from the Breakpoints list box

» Press the Delete button to delete this breakpoint from the Breakpoints list box

* Press the OK button to confirm

To Delete all Breakpoints

* Choose the Breakpoint command from the Debug menu or press the hot key Ctrl+B
A breakpoint dialog box is displayed (Fig 5-3)

» Choose the Clear All button to delete all breakpoints from the Breakpoints list box

* Press the OK button to confirm

* You can also click the Clear All Breakpoint button on the toolbar to accomplish this task.

To Enable (Disable) a Breakpoint

* Choose the Breakpoint command from the Debug menu or press the hot key Ctrl+B
A breakpoint dialog box is displayed (Fig 5-3)

* Choose the disabled (enabled) breakpoint from the Breakpoints list box

» Press the Enable (Disable) button, to enable or disable this breakpoint

* Press the OK button to confirm

Trace the Application Program

The HT-IDE3000 provides a powerful trace mechanism which records the execution processes

and all relative information when the HT-IDE3000 is emulating the application program. The trace

mechanism provides qualifiers to filter specified instructions and trigger conditions in order to stop
the trace recording. It also provides a method to record a specified count of the trace records before
or after a trigger point.

Note: When the HT-IDE3000 starts emulating (refer to the section on Emulation of the Application
Programs), the trace mechanism will begin to record the executing instructions and relative
information automatically, but not vice versa.

Only the ICE supports the trace mechanism function. The e-ICE and OCDS do not support
this function.

Initiating the Trace Mechanism

The basic requirement for initializing the trace mechanism is to set the Trace Mode with or without
Qualify. The Trace Mode defines the trace scope of the application program and Qualify defines the
filter conditions of the trace recording.

The available Trace Modes are:

* Normal
Sets the trace scope to all application programs and is the default mode.
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Trace Main

Sets the trace scope to all application programs except the interrupt service routine programs.
Trace INT

Sets the trace scope to all interrupt service routine programs.

According to Qualify, the trace mechanism decides which instructions and what corresponding

information should be recorded in the trace buffer during the emulation process. The rule is that an

instruction will be recorded if its information and status satisfy one of the enabled qualifiers. If all
the program steps are required to be recorded, then No Qualify is needed (do not set the Qualify).
The default is No Qualify.

Qualify format

[source file name!].line number
where the source file name is a name of the optional source file. If there is no file name, the

@)

current active file is assumed. The exclamation point is necessary only when a source file
name is specified. The dot . must prefix the line number which is decimal.
For example:

C:\HIDE\USER\GE.ASM!.42

Only the code executed at the 42nd line of the file GE.ASM is recorded.
For example:

.48
Only the code executed at the 48nd line of the current active file is recorded.

[source_file name!].symbol name

All are the same as the line number location format except that the line number is replaced with
symbol name. The following program symbols are acceptable:

+ Label name

+ Section name

+ Procedure name

+ Dynamic data symbols defined in data section

In contrast to the Trace Mode and Qualify, which specify the conditions of trace recording, both the

Trigger Mode and Forward Rate specify the conditions to stop the trace recording.

The Trigger Mode specifies the kind of the stop trace trigger point, and is a standard used to

determine the location of the stop trace point. The Forward Rate specifies the trace scope between

the trigger point and the stop trace point.

The available Trigger Modes are:

No Trigger

No stopping of the trace recording condition. This is the default case.
Trigger at Condition A

The trigger point is at condition A.

Trigger at Condition B

The trigger point is at condition B.

Trigger at Condition A or B

The trigger point is at either condition A or condition B.

Trigger at Condition B after A

The trigger point is at condition B after condition A has occurred.
Trigger when meeting condition A for k times

The trigger point is when condition A has occurred k times.
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» Trigger at Condition B after meeting A for k times
The trigger point is at condition B after condition A has occurred for k times.

Condition A and Condition B specify the trigger conditions. The format of condition A or B is the
same as that of the Qualify.

The Loop Count specifies the number of occurrences of the specified condition A. It is used only
when the Trigger Mode is from one of the last two modes in the above list.

The Forward Rate specifies the approximate rate of the trace recording information between the
trigger point and stop trace point in the whole trace buffer. The trigger point divides the trace buffer
into two parts, before and after trigger point. The forward rate is used to limit the trace recording
scope after the trigger point. The percentage is adjustable between 0 and 100%.

Note: It is not necessary for the trace recording scope to be equal to the forward rate. If a breakpoint
is met before reaching the trace recording scope or a trace stop command (refer to: Stopping
the trace mechanism) is issued, the trace recording will be stopped.

A Qualify list box records and displays all qualifiers used by the Trace Mode. Up to 20
qualifiers can be added into the list box and and up to 6 qualifiers can be effective. A Qualifier
can be disabled or deleted from the list box. In the Qualify list box,

the format of the qualifier is
<status> ({<space and read/write>, <location>,
<data content>, <external signal>}
where <status> is effective status. “+” is effective (enabled) and “—” is non-effective (disabled).
<space and read/write> is the space type and operating mode. “C” is the code space, "D/R" is the
data space with read, “D/W” is the data space with write, “D/RW” is the data space with read and
write.

<location>, <data content> and <external signal> have the same data format as the input form
respectively.

Stopping the Trace Mechanism

There are 3 methods to stop the trace recording mechanism:

 Set the trigger point (Trigger Mode) and Forward Rate as shown above

» Set breakpoints to stop the the emulation and the trace recording

* Issue a Trace Stop command from the Debug menu (Fig 5-2) to stop the trace recording

Fig 5-4 lists all the requirements to use the trace mechanism. This is the result of the Trace command
from the Debug menu.

Trace Start/Stop Setup

* To Set the Trace Mode

* Choose the Trace command from the Debug Menu
A Trace dialog box is displayed as in Fig 5-4

* Choose a trace mode from the Trace Mode pull-down list bo

e Press the OK button
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Fig 5-4
To Set the Stop Trace Trigger Mode

* Choose the Trace command from the Debug Menu
A Trace dialog box is displayed as in Fig 5-4

* Choose a trigger mode from the Trigger Mode pull-down list box
 press the OK button
To Change the Forward Rate

* Choose the Trace command from the Debug Menu
A Trace dialog box is displayed as in Fig 5-4

» Use the Forward Rate scroll bar to specify the desired rate
* Press the OK button
To Setup the Condition A/Condition B

* Choose the Trace command of the Debug Menu
A Trace dialog box is displayed as Fig 5-4

* Press Condition A/Condition B radio button
* Press the Set Condition button
A Set Qualify dialog box is displayed as in Fig 5-5
+ Enter the conditional information
* Press the OK button to close the Set Condition dialog box
» Press the OK button to closethe Trace dialog box
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Set Condition A

Space: @ Code () Data

Location: Cancel

resd write

Fig 5-5

To Add a Trace Qualify Condition

Choose the Trace command from the Debug Menu
A Trace dialog box is displayed as in Fig 5-4

Press the Qualify radio button

Press the Set Qualify button

A Set Qualify dialog box is displayed as in Fig 5-5

Enter the qualifier information

Press the OK button to close the Set Qualify dialog box

Press the Add button to add the qualifiers into the Qualify list box below
Press the OK button to close the Trace dialog box

To Delete a Trace Qualify Condition

Choose the Trace command from the Debug Menu
A Trace dialog box is displayed as in Fig 5-4

Choose the qualify line to be deleted from the Qualify list box
Press the Delete button
Press the OK button to confirm

To Delete All Qualify Conditions

Choose the Trace command from the Debug Menu
A Trace dialog box is displayed as in Fig 5-4

Press the Clear All button
Press the OK button to confirm

Note: If there is no qualifier, all instructions are qualified by default.
To Enable (Disable) a Trace Qualify Condition

Choose the Trace command from the Debug Menu
A Trace dialog box is displayed as in Fig 5-4

Choose the disabled (enabled) qualifier line to be enabled (disabled) from the Qualify list box
Press the Enable (disable) button
Press the OK button to confirm

Note: At most, 6 trace qualifications can be enabled at the same time. The ¢-ICE is limited to the

Normal Mode, the trace range is for the whole application program.
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Trace Record Format

Once the trace qualify and trigger conditions have been setup, those instructions which satisfy the
qualify conditions will be recorded in the trace buffer. The trace recorded fields may not all be
displayed on the screen except for the sequence number and disassemble instructions. These fields
are dependent upon the Trace Recoord Fields settings in the Debug option attribute page of Project
Settings sub-menu from the Options menu. The text enclosed by the parentheses are the headings
shown in the Trace List command of the Window menu. Fig 5-6 and Fig 5-7 illustrate the contents
of the trace list under the different debug options.

No. PC CODE IHSTRUCTIOHW DAT FILE-LINE SOURCE
-89: oasa Hou A, BH a
-B@18:  oo@1 Mou [4H].n B
-8m7: aae2 CALL 17H 17
-B6: aa17 HMou A, BH a
-8@15:  @o18 Mou [4H].n B
-BEiy: aa19 CALL 1dH 10
-8m3: aa1p RET a
-B2: aa1a HMou A, BH a
- -8 aa1g Hou [4H].A B
-@8816: @81c RET a
-8e89: 083 JHP 6H 6
-0e6s : 0a86 CLR [46H] a
-00e7:  0Oe7 CLR [41H] 5}
-8G5 : 0868 HMou A,1H 1
-9egs5: 089 HMou [#2... 1
-B004: pAbBA GLR [43H] a
-8e83: aa6B Hou A,2H 2
-0082: 0O8C Hou [44... 2
-8e81: aaep CLR [1!5H] a
< 2
Fig 5-6

* Sequence number (No)
For any of the trigger modes, the sequence number of a trigger point is +0. The trace records
before and after the trigger point are numbered using negative and positive line numbers
respectively. If all the fields of the Trace Record Fields (the Trace Recoord Fields settings in the
Debug option attribute page of Project Settings sub-menu in the Options menu) are selected,
the result is as shown in Fig 5-7. If No trigger mode is selected or the trigger point has not yet
occurred, the sequence number starts from -00001 and decreases 1 sequentially for the trace
records (Fig 5-6).

* Program count (PC)
The program count of the instruction in this trace record.

* Machine code (CODE)
The machine code of this instruction.

» Disassembled instruction (INSTRUCTION)
The disassembled mnemonic instruction is disassembled using an HT-IDE3000 utility.

* Execution data (DAT)
The data content to be executed (read/write).

* Source file name with a line number (FILE-LINE)
The source file name and the line number of this instruction.

* Source file (SOURCE)
The source line statement (including symbols).

All the above fields are optional except the sequence number which is always displayed.
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Trace X
No. PC GCODE = INSTRUCTION DAT FILE-LINE SOURCE
-6619: B@@8 @FE8 MOV A, BH ] test.c(7) void main()
-0818: Pa@81  @e84 HOU [4H],A @
-8817: @082 2817 CALL 17H 17
-8816: B@17 GFE8 HOU A,BH a test.c(7) void main()
-8815: B@18 @684 HOU [#H],n @
-8814:  B819 281D CALL 1dH 1D
-0813: B@1D @883 RET a test.c(?) void main{)
-8812: B@1A  @FEB MOV A, BH a
-~ -@@11:  @e1B  oegh HOU [4H],n @
-6a1@: BaiC @883 RET a
-Bea9: pa@e3 2886 JMP 6H [
-0oes: Be@6 1F4B CLR [48H] ] test.c{18) a=8;
-Be87: Bae7 1F41  CLR [41H] a
-0086: BOB8 @FE1 MOV A,1H 1 test.c{12) b=1;
-0@e5: PA@d9 @ec2 Hou [42... 1
-8864: B00A 1F43 CLR [43H] (]
-BA83: PABBE @FB2 MOV A,2H 2 test.c(13) c=2;
-0882: PGABC @eChH HOU [4b... 2
-Be@1: PABD 1F45 CLR [45H] a
< >
Fig 5-7

Note: To set the trace record fields by modifying the Trace Recoord Fields settings in the Debug

option attribute page of Project Settings sub-menu in the Options menu.
To view the trace record fields use Trace List command of the Window menu.

Clear the Trace Buffer

The trace buffer can be cleared by issuing the Reset Trace command. Hereafter, the trace
information will be saved from the beginning of the trace buffer. Note that both the Reset
command and the Power-On Reset command also clear the trace buffer.
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Chapter 6 Menu — Window

The HT-IDE3000 provides various kinds of windows which assist the user to emulate or simulate
application programs. These windows (as shown in Fig 6-1) include program Data Memory (RAM),
program code memory (ROM), Trace List, Register, Watch , Stack, Program, Output, etc.
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Fig 6-1
Window Menu Commands

Workspace
The Workspace window lists out all of the source files in the project. As shown in Fig 6-2, here
chosen source files can be quickly selected. Files can be added or removed here.

= Project: HTERFBSSD {*)
g MCU: HTAEFBSS0
F-J Source Files

- Startup Code

..... I OB Files

..... ] Header Files
- External Files

| (oA Work Space | (53 Class View

Fig 6-2
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RAM
The RAM window display the contents of the program Data Memory space as shown in Fig 6-3
The address spaces of the registers are not included in the RAM window because they are displayed
in the register window. The contents of the RAM window can be modified directly for debugging
purpose. The address displayed vertically is the base address while the horizontal single digit
address is the offset. All the digits are displayed in hexadecimal format. The Address field can input
an address for direct location and the Column filed is used to specify the number of columns.

RAM b4
Address: I:I Column:
ADDFD 1 2 3 4 &5 B 7 »

g0: @@ @2 @7 0 @@ @Y e @ . .
g8 @ @2 @7 0 @@ @Y e @ ...
90 @@ @@ @1 0@ @@ o @@ @@ ... .
95 @0 @@ @1 0 @@ a@F @@ @@ ... .
Al @@ @@ @@ @@ @@ @9 @@ @@ .
AR @@ @@ @@ @@ @@ @9 @@ @@ .
E0l: @@ @@ @@ @@ @@ @9 @@ @@ . . .
B @@ @@ @@ @@ @@ @9 @@ @@ . .
Co:@@ @@ @2 @@ @@ @@ af @@ . . .. . ...
CE:ae @ @ 0 @9 e @@ @ .
Do: @@ @@ @2 @@ @2 @@ @@ @a . . .
De: ag @@ @ @0 @2 @ @@ @ . . .
E0: @@ @@ @2 @@ @2 @@ @@ @a . .. . .
Eg: @@ @@ @2 o @@ o ae @a . .
FO: @@ @@ @2 oo @@ o @@ oo . .

L L O 1 1 U 1 L ) T ) T o) ST el S
M 4 » w RAMD (RAMI [RAMZ [ REMG /| RAMM [ RAMS

| GwRAM | g ROM

m

Fig 6-3

ROM
The ROM window displays the contents of the program code memory space as shown in Fig 6-4.
The ROM address range is from 0 to last address where the last address depends upon the MCU
selected in the project. The horizontal and vertical scrollbars can be used to view any address in the

ROM window. The contents in ROM window are displayed in hexadecimal format and cannot be
modified.

ROM b4

Address: | =

ADDR 1] 1 2 3 4 = = -
ooon:
ooio:
ooz0:
0o3n:
oo4dn:
00s0:
ooen:
0nzo:
oosn:
o090 :
00aD:
00B0:
0oco:
oooan -
00ED:
00FD: =
4 [ T b

GREAM | gROM

Fig 6-4
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Trace List

The Trace List window displays the trace record information as shown in Fig 6-5. The contents of

the trace record can be defined in the Debug command in the Options menu. Double click the trace

record in the Trace List window will activate the source file window and the cursor will stop at the

corresponding line.

Register

m Trace E@@
Ho. PC CODE IMSTRUCTIOHN DAT FILE-LIHNE

-08821:83DE BFO88 HOU A,BH B init.asm{84) jﬁ
-08820:083DC 8BDO MOV [58H] .A a

-088192:683DD BFB81 HOU A,1H 1 init.asm(87)
-08818:83DE B88D1 HOU [51H],ﬂ 1

-88817:083DF BF88 HOU A,BH @ init.asm({88)
-88816:-083EQ BAD2 HOU [52H],H a

-08815:083E1 BF68 HOU A,68H 68 init.asm(91)
-08814:083E2 88D3 HOU [53H].A 68

-88813:03E2 OF81 HOU A.1H 1 init.asm(92)
-08812:03E4 B88D4 HOU [5“H],ﬂ 1

-08811:083E5 BF9246 HOU A,96H 96 init.asm(95)
-08810:083E6 8ADS MOV 55H],.A 26
F00005 0357 0r 08 MOV Ao D ANIEiasn(9)
-0088088 - A3ER BADAG HOU [56H],ﬂ a

-08887 - 83E? BF41 HOU A,4%1H ¥ init.asm{299)
-0888086:-083EA BAD7 MOV [57H] .A 1

-00805:03EE BFAA HOU A, BH 8 init.asm{108)
-00804:83EC 88DE HOU [58H].A a

-888083:083ED 1F66 CLR [66H] 8 init.asm{114)
-008882:03EE 1F67 CLR [6?H] 8 init.asm{115)
—-08881:083EF 8883 RET 8 init.asm{116) 3
< >

Fig 6-5

The Register window displays all the registers defined in the MCU selected in the project. Fig 6-6

shows an example of the Register window of HT48C70-1. The contents of the Register window can

be modified for debugging. Note that the Register window is dockable.

MP@  :[01H] = OBH ~
MP1  :[03H] = @BH
BP :[04H] = @BH
ACC  :[O5H] = OBH
PCL  :[06H] = 2BH
TBLP :[07H] = OBH
TBLH :[08H] = FFH
STATUSZ[OBAH] = B7FH 2 AC C
INTCA :[OEH] = OO6H
TMRBH :[GCH] = @6H
THRBL :[GDH] = @6H
THRBC :[OEH] = @8H TOE
THRAH :[GFH] = @6H
THRIL :=[16H] = @6H
THRIC :[11H] = @8H T1E
PR :[12H] = FFH PA7 PA6 PAS
PAC  :[13H] = 6BH v
< 4
Fig 6-6
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Watch

The Watch window displays the memory addresses and contents of the specified symbols defined in
the data sections, i.e., in the RAM space.

» The contents of the registers can also be displayed by typing the symbol name or register name
and then pressing the Enter key. The memory address and contents of the specified symbol or
register will be displayed to the right of the symbol.

» Display the specified symbol that belongs to the RAM or ROM space.

* Address is displayed in hexadecimal format, and data is displayed in decimal, hexadecimal or
binary format as shown in Fig 6-7. The symbol and their corresponding data will be saved by
the HT-IDE3000 and displayed the next time the Watch window is opened. The symbols can be
deleted from Watch window by pressing the delete key. Note that the Watch window is dockable.

Watechl v 1 X

Hame Ualue Address Space |
& a a Gxaag2 Ram
$ b 1 Ov AAS A Ram

* Hexadecimal Display

Decimal Display

Binary Display

Eﬂutput l,@'ﬂatchl ]ﬂﬁmtn @Eanal hBu:u:-kmarks

Fig 6-7

Stack

The Stack window displays the contents of the stack buffer for the MCU selected in the current
project. The maximum stack level is dependent upon the MCU selected. Fig 6-8 shows an example
of the Stack window. The growth of the stack is numbered from 0. The number is increased by 1
for a push operation (CALL instruction or interrupt) and decreased by 1 for a pop operation (RET
or RETI instructions). The arrow on the left indicates the highest stack level, where the text will be
highlighted. The unused parts of the stack buffer are shown with “@@@@”. The top stack line is
highlighted. E.g. The 01: shown in Fig 6-8 is the top stack line. While executing a RET or RETI
instruction, the program line number specified in the top stack line (26 in this example) will be
used as the next instruction line to be executed. Also, the line above the top stack line (00: in this
example) will be used as the new top stack line. If there is no stack line anymore, no line in the
Stack window will be highlighted. In addition, the ICE STKPTR points to the next stack level for
the ICE internal Stack Pointer. If the ICE STKPTR=00, Stack Status: E/E, then it means that the
stack is empty or has just become full. The format of the stack line is:
Stack level: program counter source file name(line number)

where the stack level is the level number of the stack, program_counter is the hexadecimal return
address of the calling procedure or the program address of the interrupted instruction, source_file
name is the complete name of the source file containing the calling or interrupted instruction, and
line_number is the decimal line number of the instruction after the call instruction or interrupted
instruction in the source file.
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ga: 1738 -
B1: @Da3
B2: 1781
A3: 1323
B4: 1716
B5: G478
B6: B4CA1
87 : 1E27

ICE STEPTE = 00 Stack Status: E/F
Fig 6-8

Variable

This window can view and modify variable values, including two tabs:

* Auto tab, this tab can observe and set both local variables and global variables related to the
current function.

» Local tab, this tab can observe and set local variables related to the current function.

Hame Ualue Address Space |
@ a a 8x 0082 Ram
b 1 BxA0808 Ram

Eﬂutput |'|'|'atch1 lgﬁmtn @anal iB-:u:-kmarks

Fig 6-9

Program
The Program window displays the program code memory or ROM in disassembly format. The
address range is from 0 to last address where the last address depends upon the MCU selected in the
project.

Disassembly
The Disassembly Window shows mixed high-level source code and its associated assembler code.
Each instruction is marked with code coverage indicators that show execution status
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Disassembly X
PC CODE INSTRUCTION

@Bcode .SECTION 'CODE® -

include HT67F489.inc
gasa 2801 jmp _main_startupi

@start .SECTION 'CODE*

_main_startup1:

@start .SECTION 'CODE*
8881 2882 jmp _main

H volatile int a=8;

_main:

_main:

{1153 SFB2 clr a[ 8]
0003 5Fe3 clr a[1]

;6 volatile int b=1;
aaay BF 81 nov a, 1H =
80885 4880 nov b[e], a 1
8806 SFe1 clr b[1]

i a+=b;

0807 4700 nou a, b[a]
o068 4382 addm a, a[a]
[i]:1:1 4701 nov a, b[1]
aaen 5383 adcm a, a[1]
_L2:
o068 2808 jmp $
aenc 2800 jmp $
H: ] while{1};
H =
Fig 6-10

Output
The Output window shows the system messages from the HT-IDE3000 when the Build/Rebuild All
commands are executing. By double clicking on the error message line, the window containing the
source file will be displayed and the corresponding line containing the error highlighted.

The Output window also displays the Program Checksum and the Program Verify Code. This can
assist the user to know if the program has been modified.
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Chapter 7 Assembly Language and Cross Assembler

Assembly-Language programs are written as source files. They can be assembled into object files by
the Cross Assembler. Object files are combined by the Cross Linker to generate a task file.

A source program is made up of statements and look up tables, giving directions to the Cross
Assembler at assembly time or to the processor at run time. Statements are constituted by
mnemonics (operations), operands and comments.

Notational Conventions

The following list describes the notations used by this document.

Example of convention Description of convention

Syntax elements that are enclosed by a pair of brackets are optional. For
example, the syntax of the command line is as follows:

HASM [options] filename [;]
[optional items] In the above command line, options and semicolon; are both optional, but
filename is required, except for the following case:
Brackets in the instruction operands. In this case, the brackets refer to
memory address.

Braces and vertical bars stand for a choice between two or more items.
{choice1 | choice2} Braces enclose the choices whereas vertical bars separate the choices.
Only one item can be chosen.

Three dots following an item signify that more items with the same form
may be entered. For example, the directive PUBLIC has the following

. form:

Repeating elements... PUBLIC namel [,name2 [,..]]

In the above form, the three dots following name2 indicate that many

names can be entered as long as each is preceded by a comma.

Statement Syntax

The construction of each statement is as follows:
[name] [operation] [operands] [;comment]

All fields are optional.

Each field (except the comment field) must be separated from other fields by at least one space or
one tab character.

Fields are not case-sensitive, i.e., lower-case characters are changed to upper-case characters before
processing.

Name
Statements can be assigned labels to enable easy access by other statements. A name consists of the
following characters:
A7 oavz 09 2 @
with the following restrictions :
» 0~9 cannot be the first character of a name

e ? cannot stand alone as a name

* Only the first 31 characters are recognized
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Operation

The operation defines the statement action of which two types exist, directives and instructions.
Directives give directions to the Cross Assembler, specifying the manner in which the Cross
Assembler is to generate the object code at assembly time. Instructions, on the other hand, give
directions to the processor. They are translated to object code at assembly time, the object code in
turn controls the behavior of the processor at run time.

Operand

Operands define the data used by directives and instructions. They can be made up of symbols,
constants, expressions and registers.

Comment

Comments are the descriptions of codes. They are used for documentation only and are ignored by
the Cross Assembler. Any text following a semicolon is considered a comment.

Assembly Directives

Directives give direction to the Cross Assembler, specifying the manner in which the Cross
Assembler generates object code at assembly time. Directives can be further classified according to
their behavior as described below.

Conditional Assembly Directives

The conditional block has the following form:
IF
statements
[ELSEIF
Statements]
[ELSE
statements]
ENDIF

Syntax
IF expression
IFE expression

Description

The directives IF and IFE test the expression following them.

The IF directive grants assembly if the value of the expression is true, i.e. non-zero.
The IFE directive grants assembly if the value of the expression is false, i.e. zero.

Example
IF debugcase
ACCl equ 5
extern username: byte
ENDIF
In this example, the value of the variable ACCI is set to 5 and the username is declared as an
external variable if the symbol debugcase is evaluated as true, i.e. nonzero.

Syntax

IFDEF name
IFNDEF name

Description

The directives IFDEF and IFNDEF test whether or not the given name has been defined. The IFDEF
directive grants assembly only if the name is a label, a variable or a symbol. The IFNDEF directive
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grants assembly only if the name has not yet been defined. The conditional assembly directives
support a nesting structure, with a maximum nesting level of 7.

Example
IFDEF buf flag
buffer DB 20 dup (?)
ENDIF

In this example, the buffer is allocated only if the buf flag has been previously defined.

Syntax

IF DEFINE EXP
ELSEIF DEFINE EXP
IFE DEFINE EXP

Description

(1). DEFINE_EXP Supported Syntax:

DEFINED name [ | DEFINE EXP]
DEFINED name [ & DEFINE EXP]
IDEFINED name [ | DEFINE EXP]
IDEFINED name [ & DEFINE EXP]

(2). If the name has been defined, then the value of DEFINED name is true, otherwise the value is false.
(3). For more than one DEFINED names, using the operators of &(AND), | (OR) to combine them.
(4). IF |DEFINED name is equal to IFE DEFINED name.

Example
V3 EQU 3
IF (DEFINED V1 | DEFINED V3 )
NOP
ENDIF

In this example, NOP will be executed.

File Control Directives

Syntax
INCLUDE file-name

or
INCLUDE file-name

Description
This directive inserts source codes from the source file given by file-name into the current source file
during assembly. Cross Assembler supports at most 7 nesting levels.
Example
INCLUDE macro.def
In this example, the Cross Assembler inserts the source codes from the file macro.def into the
current source file.
Syntax
PAGE size
Description
This directive specifies the number of the lines in a page of the program listing file. The page size
must be within the range from 10 to 255, the default page size is 60.
Example
PAGE 57

This example sets the maximum page size of the listing file to 57 lines.
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Syntax
JLIST
.NOLIST
Description

The directives .LIST and .NOLIST decide whether or not the source program lines are to be copied
to the program listing file. .NOLIST suppresses copying of subsequent source lines to the program
listing file. .LIST restores the copying of subsequent source lines to the program listing file. The
default is .LIST.
Example

.NOLIST

mov a, 1

mov bl, a
.LIST

In this example, the two instructions in the block enclosed by .NOLIST and .LIST are suppressed
from copying to the source listing file.

Syntax

.LISTMACRO
.NOLISTMACRO

Description
The directive .LISTMACRO causes the Cross Assembler to list all the source statements, including

comments, in a macro. The directive .NOLISTMACRO suppresses the listing of all macro
expansions. The default is NOLISTMACRO.

Syntax

.LISTINCLUDE
.NOLISTINCLUDE

Description
The directive .LISTINCLUDE inserts the contents of all included files into the program listing.

The directive .NOLISTINCLUDE suppresses the addition of included files. The default is
.NOLISTINCLUDE.

Syntax
MESSAGE ’text-string’
Description
The directive MESSAGE directs the Cross Assembler to display the text-string on the screen. The
characters in the text-string must be enclosed by a pair of single quotation marks.
Syntax
ERRMESSAGE ’error-string’
Description
The directive ERRMESSAGE directs the Cross Assembler to issue an error. The characters in the
error-string must be enclosed by a pair of single quotation marks.

Program Directives

Syntax (comment)
; text
Description
A comment consists of characters preceded by a semicolon (;) and terminated by an embedded
carriage-return/line-feed.
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Syntax
name .SECTION [align] [combine] ‘class’

Description

The .SECTION directive marks the beginning of a program section. A program section is a
collection of instructions and/or data whose addresses are relative to the section beginning with the
name which defines that section. The name of a section can be unique or be the same as the name
given to other sections in the program. Sections with the same complete names are treated as the
same section. The optional align type defines the alignment of the given section. It can be one of the

following:

BYTE uses any byte address (the default align type)
WORD uses any word address

PARA uses a paragraph address

PAGE uses a page address

For the CODE section, the byte address is in a single instruction unit. BYTE aligns the section at
any instruction address, WORD aligns the section at any even instruction address, PARA aligns
the section at any instruction address which is a multiple of 16, and PAGE aligns the section at any
instruction address with a multiple of 256.

For DATA sections, the byte address is in one byte units (8 bits/byte). BYTE aligns the section at
any byte address, WORD aligns the section at any even address, PARA aligns the section at any
address which is a multiple of 16, and PAGE aligns the section at any address which is a multiple of
256. The optional combine type defines the way of combining sections having the same complete
name (section and class name). It can be any one of the following:

+ COMMON
Creates overlapping sections by placing the start of all sections with the same complete name at
the same address. The length of the resulting area is the length of the longest section.

+ AT address

Causes all label and variable addresses defined in a section to be relative to the given address.
The address can be any valid expression except a forward reference. It is an absolute address in a
specified ROM/RAM bank and must be within the ROM/RAM range.

If no combine type is given, the section is combinative, i.e., this section can be concatenated with
all sections having the same complete name to form a single, contiguous section. The class type
defines the sections that are to be loaded in the contiguous memory. Sections with the same class
name are loaded into the memory one after another. The class name CODE is used for sections
stored in ROM, and the class name DATA is used for sections stored in RAM. The complete
name of a section consists of a section name and a class name. The named section includes all
codes and data below (after) it until the next section is defined.

Syntax
ROMBANK banknum section-name [,section-name,...]

Description

This directive declares which sections are allocated to the specified ROM bank. The banknum
specifies the ROM bank, ranging from 0 to the maximum bank number of the destination MCU. The
section-name is the name of the section defined previously in the program. More than one section
can be declared in a bank as long as the total size of the sections does not exceed the bank size of
8K words. If this directive is not declared, bank 0 is assumed and all CODE sections defined in
this program will be in bank 0. If a CODE section is not declared in any ROM bank, then bank 0 is
assumed.
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Syntax
RAMBANK banknum section-name [,section-name,...]

Description

This directive is similar to ROMBANK except that it specifies the RAM bank, the size of RAM
bank is 256 bytes.

Syntax
END

Description

This directive marks the end of a program. Adding this directive to any included file should be
avoided.

Syntax
ORG expression

Description

This directive sets the location counter to expression. The subsequent code and data offsets begin
at the new offset specified by expression. The code or data offset is relative to the beginning of the
section where the directive ORG is defined. The attribute of a section determines the actual value of
offset, absolute or relative.

Example
ORG 8
mov A, 1
In this example, the statement mov A, 1 begins at location 8 in the current section.

Syntax
PUBLIC namel [,name2 [,...]]
EXTERN namel:type [,name2:type [,...]]

Description

The PUBLIC directive marks the variable or label specified by a name that is available to other
modules in the program. The EXTERN directive, on the other hand, declares an external variable,
label or symbol of the specified name and type. The type can be one of the three types: BYTE, BIT
(these two types are for data variables), and NEAR (a label type and used by call or jmp).

Example
PUBLIC start, setflag
EXTERN tmpbuf:byte
CODE .SECTION ‘CODE"
start:
mov a, 55h
call setflag

setflag proc
mov tmpbuf, a
ret
setflag endp
end
In this example, both the label start and the procedure setflag are declared as public variables.
Programs in other sources may refer to these variables. The variable tmpbuf is also declared as
external. There should be a source file defining a byte that is named tmpbuf and is declared as a
public variable.

Syntax

name PROC
name ENDP
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Description

The PROC and ENDP directives mark a block of code which can be called or jumped to from other
modules. The PROC creates a label name which stands for the address of the first instruction of a
procedure. The Cross Assembler will set the value of the label to the current value of the location
counter.

Example
toggle PROC
mov tmpbuf, a
mov a, 1
xorm  a, flag
mov a, tmpbuf
ret
toggle ENDP
Syntax
[label:] DC expressionl [,expression? [,...]]

Description

The DC directive stores the value of expressionl, expression2 etc. in consecutive memory locations.
This directive is used for the CODE section only. The bit size of the result value is dependent on the
ROM size of the MCU. The Cross Assembler will clear any redundant bits; expressionl has to be a
value or a label. This directive may also be employed to setup the table in the code section.

Example

table: DC 0128H, 025CH
In this example, the Cross Assembler reserves two units of ROM space and also stores 0128H and
025CH into these two ROM units.

Data Definition Directives

An assembly language program consists of one or more statements and comments. A statement or
comment is a composition of characters, numbers, and names. The assembly language supports
integer numbers. An integer number is a collection of binary, octal, decimal, or hexadecimal digits
along with an optional radix. If no radix is given, the Cross Assembler uses the default radix
(decimal). The table lists the digits that can be used with each radix.

Radix Type Digits
B Binary 01
0} Octal 01234567
D Decimal 0123456789
H Hexadecimal |0123456789ABCDEF

Syntax

[name] DB valuel [,value2 [,...]]
[name] DBIT
[name] DB repeated-count DUP(?)

Description

These directives reserve the number of bytes specified by the repeated-count or reserve bytes only.
valuel and value2 should be ? due to the microcontroller RAM . The Cross Assembler will not
initialize the RAM data. DBIT reserves a bit. The content ? denotes uninitialized data, i.e., reserves
the space of the data. The Cross Assembler will gather every 8 DBIT together and reserve a byte for
these 8 DBIT variables.
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Example
DATA  .SECTION  ‘DATA’
tbuf DB ?
flagl  DBIT
sbuf DB ?
cflag ~ DBIT

In this example, the Cross Assembler reserves byte location 0 for tbuf, bit 0 of location 1 for flagl,
location 2 for sbuf and bit 1 of location 1 for cflag.

Syntax
name LABEL {BIT|BYTE|WORD}

Description

The name with the data type has the same address as the following data variable.

Example
labl LABEL WORD
dl DB ?
d2 DB ?

In this example, d1 is the low byte of labl and d2 is the high byte of labl.

Syntax
name EQU expression

Description

The EQU directive creates absolute symbols, aliases, or text symbols by assigning an expression
to name. An absolute symbol is a name standing for a 16-bit value; an alias is a name representing
another symbol; a text symbol is a name for another combination of characters. The name must be
unique, i.e. not having been defined previously. The expression can be an integer, a string constant,
an instruction mnemonic, a constant expression, or an address expression.

Example

accreg EQU 5
bmove EQU mov

In this example, the variable accreg is equal to 5, and bmove is equal to the instruction mov.

Macro Directives

Macro directives enable a block of source statements to be named, and then that name to be re-used
in the source file to represent the statements. During assembly, the Cross Assembler automatically
replaces each occurrence of the macro name with the statements in the macro definition.

A macro can be defined at any place in the source file as long as the definition precedes the first
source line that calls this macro. In the macro definition, the macro to be defined may refer to other
macros which have been previously defined. The Cross Assembler supports a maximum of 7 nesting
levels.

Syntax

name MACRO [dummy-parameter [,...]]
statements
ENDM

The Cross Assembler supports a directive LOCAL for the macro definition.
Syntax

name LOCAL dummy-name [,...]
Description
The LOCAL directive defines symbols available only in the defined macro. It must be the first line
following the MACRO directive, if it is present. The dummy-name is a temporary name that is
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replaced by a unique name when the macro is expanded. The Cross Assembler creates a new actual
name for dummy-name each time the macro is expanded. The actual name has the form ??digit,
where digit is a hexadecimal number within the range from 0000 to FFFF. A label should be added
to the LOCAL directive when labels are used within the MACRO/ENDM block. Otherwise, the
Cross Assembler will issue an error if this MACRO is referred to more than once in the source file.

In the following example, tmpl and tmp2 are both dummy parameters, and are replaced by
actual parameters when calling this macro. labell and label2 are both declared LOCAL, and are
replaced by ??0000 and ??0001 respectively at the first reference, if no other MACRO is referred.
If no LOCAL declaration takes place, labell and label2 will be referred to labels, similar to the
declaration in the source program. At the second reference of this macro, a multiple define error
message is displayed.
Delay MACRO tmpl, tmp2
LOCAL labell, label2

mov a, 70h
mov tmpl, a

labell:
mov tmp2, a
label2:
clr wdtl
clr wdt2
sdz tmp2
jmp label?
sdz tmpl
jmp labell
ENDM

The following source program refers to the macro Delay ..

; T.ASM
Sample program for MACRO.
.ListMacro
Delay MACRO tmpl, tmp2
LOCAL labell, label2

mov a, 70h
mov tmpl, a
labell:
mov tmp2, a
label2:
clr wdtl
clr wdt2
sdz tmp2
jmp label2
sdz tmpl
Jjmp labell
ENDM
data .section 'data'
BCnt db ?
sCnt db ?

code .section at 0 'code'
Delay BCnt, SCnt
end

The Cross Assembler will expand the macro Delay as shown in the following listing file. Note that
the offset of each line in the macro body, from line 4 to line 17, is 0000. Line 24 is expanded to 11
lines and forms the macro body. In addition the formal parameters, tmpl and tmp2, are replaced
with the actual parameters, BCnt and SCnt, respectively.
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File: T.asm Holtek Cross-Assembler Version 2.80 Page 1
1 0000 ; T.ASM
2 0000 ;  Sample program for MACRO.
3 0000 .ListMacro
4 0000 Delay MACRO tmpl, tmp2
5 0000 LOCAL labell, label2
6 0000 mov a, 70h
7 0000 mov tmpl, a
8 0000 labell:
9 0000 mov tmp2, a
10 0000 label2:
11 0000 clr wdtl
12 0000 clr wdt2
13 0000 sdz tmp2
14 0000 Jmp label2
15 0000 sdz tmpl
16 0000 jmp labell
17 0000 ENDM
18 0000
19 0000 data .section 'data'
20 0000 00 BCnt db ?
21 0001 00 scnt db ?
22 0002
23 0000 code .section at 0 'code'
24 0000 Delay BCnt, SCnt
24 0000 OF70 1 mov a, 70h
24 0001 0080 R1 mov BCnt, a
24 0002 1 220000:
24 0002 0080 R1 mov scnt, a
24 0003 1 2?20001:
24 0003 0001 1 clr wdtl
24 0004 0005 1 clr wdt2
24 0005 1780 R1 sdz scnt
24 0006 2803 1 jmp 220001
24 0007 1780 R1 sdz BCnt
24 0008 2802 1 mp 220000
25 0009 end
0 Errors
Assembly Instructions
The syntax of an instruction has the following form
[name:] mnemonic [operandl [,operand?] ] [; comment]
where
name: — label name
mnemonic — instruction name (keywords)
operandl — registers
memory address
operand2 — registers
memory address
immediate value
Name

A name is made up of letters, digits, and special characters, and is used as a label.

Mnemonic

Mnemonic is an instruction name dependent upon the type of the MCU used in the source program.

Operand, Operator and Expression

Operands (source or destination) are the argument defining values that are to be acted on by

instructions. They can be constants, variables, registers, expressions or keywords. When using the

instruction statements, care must be taken to select the correct operand type, i.e. source operand or

destination operand. The dollar sign § is a special operand, namely the current location operand.
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An expression consists of many operands that are combined to describe a value or a memory
location. The combined operators are evaluated at assembly time. They can contain constants,
symbols, or any combination of constants and symbols that are separated by arithmetic operators.

Operators specify the operations to be performed while combining the operands of an expression.
The Cross Assembler provides many operators to combine and evaluate operands. Some operators
work with integer constants, some with memory values, and some with both. Operators handle
the calculation of constant values that are known at the assembly time. The following are some
operators provided by the Cross Assembler.

Arithmetic operators
+—%/% (MOD)

SHL and SHR operators

Syntax

expression SHR count

expression SHL count
The values of these shift bit operators are all constant values. The expression is shifted right
SHR or left SHL by the number of bits specified by count. If bits are shifted out of position, the
corresponding bits that are shifted in are zero-filled. The following are such examples:

mov A, 01110111b SHR 3 ; result ACC=00001110b
mov A, 01110111b SHL 4 ; result ACC=01110000b

Bitwise operators NOT, AND, OR, XOR

Syntax
NOT expression
expressionl ~ AND expression?
expressionl  OR expression?
expressionl ~ XOR expression?

NOT is a bitwise complement.
AND is a bitwise AND.
OR is a bitwise inclusive OR.

XOR is a bitwise exclusive OR.

OFFSET operator
Syntax
OFFSET expression

The OFFSET operator returns the offset address of an expression. The expression can be a label,
a variable, or other direct memory operand. The value returned by the OFFSET operator is an
immediate operand.

LOW, MID and HIGH operator

Syntax
oW expression
MID expression
HIGH expression

The LOW/MID/HIGH operator returns the value of an expression if the result of the expression is
an immediate value. The LOW/MID/HIGH operators will then take the low/middle/ high byte of
this value. But if the expression is a label, the LOW/MID/HIGH operator will take the values of the
low/middle/high byte of the program count of this label.
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For example:
cs .section at 456H 'code'
labl:

Then:
mov a,low 9840H — mov a,40H
mov a,mid 9840H — mov a,B84H
mov a,high 9840H — mov a,98H
mov a,low labl — mov a,56H
mov a,mid labl — mov a,45H
mov a,high labl — mov a,4H

*« LOW_NIBBLE and HIGH_NIBBLE operators

Syntax

LOW NIBBLE expression

HIGH NIBBLE  expreesion
The LOW_NIBBLE operator returns the low 4-bit value of an expression while the HIGH_NIBBLE
returns the high 4-bit value of the expression. Here the expression can be an immediate value or a
label.

For example:
cs .section at 123H ‘code’
lab2:

Then:

mov A, LOW NIBBLE 23h — mov A,3H

mov A, LOW NIBBLE lab2 — mov A,3H
mov A, HIGH NIBBLE 23h — mov A,2H
mov A, HIGH NIBBLE lab2 — mov A,2H

* BANK operator

Syntax
BANK  name

The BANK operator returns the bank number allocated to the section of the name declared. If the
name is a label then it returns the rom bank number. If the name is a data variable then it returns
the ram bank number. The format of the bank number is the same as the BP defined. For more
information of the format please refer to the data sheets of the corresponding MCUs. (Note: The
format of the BP might be different between MCUs.)

Example 1:
mov A, BANK start
mov BP, A
jmp  start
Example 2:
mov A, BANK var
mov BP, A
mov A, OFFSET var
mov MP1, A
mov A, Rl
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* Operator precedence

Precedence Operators
1(Highest) (11
2 +, — (unary), LOW, MID, HIGH, OFFSET, BANK
3 *, 1, %, SHL, SHR
4 +, — (binary)
5 >(greater than), >=(greater than or equal to),
<(less than), <= (less than or equal to)
6 = = (equal to), I=(not equal to)
7 ! (bitwise NOT)
8 & (bitwise AND)
9(Lowest) | (bitwise OR), * (bitwise XOR)

Miscellaneous

Forward References
The Cross Assembler allows reference to labels, variable names, and other symbols before they are
declared in the source code (forward named references). But symbols to the right of EQU are not
allowed to be forward referenced.

Local Labels
A local label is a label with a fixed form such as $number. The number can be 0~29. The function
of a local label is the same as a label except that the local label can be used repeatedly. The local
label should be used between any two consecutive labels and the same local label name may used
between other two consecutive labels. The Cross Assembler will transfer every local label into a
unique label before assembling the source file. At most 30 local labels can be defined between two
consecutive labels.

Example
Labell: ; label
$1: ;i local label
mov a, 1
jmp $3
$2: ;i local label
mov a, 2
jmp $1
$3: ;i local label
jmp $2
Label2: ; label
Jmp $1
$0: ;i local label
jmp Labell
$1: Jmp S0
Label3:
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Reserved Assembly Language Words

The following tables list all reserved words used by the assembly language.

* Reserved Names (directives, operators)

$ DUP INCLUDE NOT
* LABEL OFFSET
+ ELSE .LIST OR
- END .LISTINCLUDE ORG
ENDIF .LISTMACRO PAGE
/ ENDM LOCAL PARA
= ENDP LOW PROC
? EQU MACRO PUBLIC
[] ERRMESSAGE MESSAGE RAMBANK
AND EXTERN MID ROMBANK
BANK HIGH MOD .SECTION
BYTE IF NEAR SHL
DB IFDEF .NOLIST SHR
DBIT IFE .NOLISTINCLUDE WORD
DC IFNDEF .NOLISTMACRO XOR
ELSEIF DEFINED HIGH_NIBBLE LOW_NIBBLE
* Reserved Names (instruction mnemonics)
ADC HALT RLCA SuUB
ADCM INC RR SUBM
ADD INCA RRA SWAP
ADDM JMP RRC SWAPA
AND MOV RRCA Sz
ANDM NOP SBC SZA
CALL OR SBCM TABRDC
CLR ORM SDz TABRDL
CPL RET SDZA XOR
CPLA RETI SET XORM
DAA RL Sz
DEC RLA SIZA
DECA RLC SNz
* Reserved Names (registers names)
A | WDT WDT1 WDT2
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Cross Assembler Options

The Cross Assembler options can be set via the Options menu Project command in HT-IDE3000.
The Cross Assembler Options is located on the center part of the Project Option dialog box, as
shown in Fig 7-1.

The symbols could be defined in the Define Symbol edit box.

Project settings @

Project Option | Debug Option | Directories | Document I F'ml:luc:tionl

Wicro Controller HT 46CU 26 -
Language Toaol:
Haltek, C Compiler ¥ 3/ssembler v] [ Build Optior... ISP Bootloader Option

Azzembler/Compiler Uptions

Define Symbal debugflag=1]

[7] Generate listing file Generate Project listing filelist)

Linker Uphons

Libraries HTEEFVIE0 Yoice. Library. I,

Sechion address
[] Generate Map Fils

(] ][ Cahcel
Fig 7-1
Syntax
symboll [=valuel] [,symbol2 [=value2 ] [,...]]
Example

debugflag=1, newver=3
The check box of the Generate listing file is used to decide whether the listing file should be
generated or not. If the check box is checked, the listing file will be generated. Otherwise, it won’t
be generated.
There is an assembly case sensitive check box in the Project’s Build Opion menu. If the check box
is checked, it represents case-sensitive. When programming in different languages, this check box is
checked in general. If the check box is not checked, it is not case-sensitive.
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Project's Build Option.., @

Compiler Settings | Linker Options
Compiler Flags | Preprocessor

Categories:
l <Al Cateqoriess - ]
[T 5top compiling after first emor [4wiatal-emors] "

[T Case sensitive for assembly

[T 5tring alignment(eg. D' 'sting1’). Twa chars will be aligned in one pragram ROM we = ‘
Enable all compiler warnings [override many other settings] [Awall] s
[]Enable extra compiler warmings [-wWestra]

[]wam if the compiler detects that code will never be executed [Wunreachable-code il
M mmb vvnmrin 6 mim samms b —bbribs ik im amm A T m — etk bmn]
< | 1 | 3

Parse Entry Function

[].8 ] [ Cancel

Fig 7-2

Assembly Listing File Format

The Assembly Listing File contains the source program listing and summary information. The first
line of each page is a title line which include company name, the Cross Assembler version number,
source file name, date/time of assembly and page number.

Source Program Listing

Each line in the source program has the following syntax:
line-number offset [code] statement
* Line-number is the number of the line starting from the first statement in the assembly source file
(4 decimal digits).
* The 2nd field “offset” is the offset from the beginning of the current section to the code (4
hexadecimal digits).

* The 3rd field “code” is present only if the statement generates code or data (two hexadecimal
4-digit data).
The code shows the numeric value in hexadecimal if the value is known at assembly time.
Otherwise, a proper flag will indicate the action required to compute the value. The following
two flags may appear behind the code field.
¢+ R — relocatable address (Cross Linker must resolve)
+ E — external symbol (Cross Linker must resolve)
The following flag may appear before the code field
+ =— EQU or equal-sign directive
The following 2 flags may appear in the code field
¢ ---—- — section address (Cross Linker must resolve)
+ nn[xx] — DUP expression: nn DUP(?)

* The 4th field “statement” is the source statement shown exactly as it appears in the source file, or
as expanded by a macro. The following flags may appear before a statement.
+ n — Macro-expansion nesting level
+ C — line from INCLUDE file
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* Summay

0 1 2 3 4 5 6
123456789012345678901234567890123456789012345678901234567890...
Il oooo hhhh hhhh EC source-program-statement

Rn

III — line number (4 digits, right alignment)
0000 — offset of code (4 digits)

hhhh — two 4-digits for opcode

E — external reference

C — statement from included file

R — relocatable name

n — Macro-expansion nesting level

Summary of Assembly
The total warning number and total error number is the information provided at the end of the Cross
Assembler listing file.

Miscellaneous
If any errors occur during assembly, each error message and error number will appear directly below
the statement where the error occurred.
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* Example of Assembly Listing Fie

File: SAMPLE.ASM Holtek Cross-Assembler Version 2.86 Page 1
1 0000 page 60
2 0000 message 'Sample Program 1'
3 0000
4 0000 .listinclude
5 0000 .listmacro
6 0000
7 0000 #include "sample.inc"
1 0000 C pa equ [12h]
2 0000 C pac equ [13h]
3 0000 C pb equ [14h]
4 0000 C pbc equ [15h]
5 0000 C pc equ [16h]
6 0000 C pcc equ [17h]
7 0000 C
8 0000
9 0000 extern extlab : near
10 0000 extern extbl : byte
11 0000
12 0000 clrpb macro
13 0000 clr pb
14 0000 endm
15 0000
16 0000 clrpa macro
17 0000 mov a, O00h
18 0000 mov pa, @
19 0000 clrpb
20 0000 endm
21 0000
22 0000 data .section 'data'
23 0000 OO0 bl db 2
24 0001 OO0 b2 db 2
25 0002 00 bitl dbit
26 0003
27 0000 code .section 'code'
28 0000 OF55 mov a, 055h
29 0001 0080 R mov bl, a
30 0002 0080 E mov extbl, a
31 0003 OFaA mov a, Oaah
32 0004 0093 mov pac, a
33 0005 clrpa
33 0005 OF00 1 mov a, 00h
33 0006 0092 1 mov [12h], a
33 0007 1 clrpb
33 0007 1F14 2 clr [1l4h]
34 0008 0700 R mov a, bl
35 0009 OFO0O0 E mov a, bank extlab
36 000A OFO00 E mov a, offset extbl
37 000B 2800 E Jmp extlab
38 000C
39 000C 1234 5678 dw 1234h, 5678h, Oabcdh, 0efl2h
ABCD EF12
40 0010 end
0 Errors
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Chapter 8 Cross Linker

What the Cross Linker Does

The Cross Linker creates task files from the object files generated by the Cross Assembler or the C
compiler. The Cross Linker combines both code and data in the object files and searches the named
libraries to resolve external references to routines and variables. It also locates the code and data
sections at the specified memory address or at the default address, if no explicit address is specified.
Finally, the Cross Linker copies both the program codes and other information to the task file. It
is this task file that is loaded by the IDE Integrated Development Environment, into the ICE In-
Circuit Emulator, for debugging. The libraries included by the Cross Linker were generated by the
library manager.

Cross Linker Options

The options specify and control the tasks performed by Cross Linker. In chapter 3, Option Menu,
Project command provides a dialog box, Cross Linker Options, to specify these options to the Cross
Linker. These options are:

Project settings IEI

Project Option | Debug Optian | Directaries I Diacurnent | Praduction

Micro Contraller HTEGFBES0 e
Language Tool:
Haltek C Compiler % 3/4ssembler - Build Optior... ] ’ISP Bootloader Option|

Azzembler/Compiler Options

Drefine Spmbil W3
Generate listing file Generate Project listing filelist)

Inker Uphons

Libraries Browse

Section address
Generate Map File

USE FIFD Size: O Bytes(D ecimal]

Ok ] [ Cancel

Fig 8-1

Libraries
Syntax
libfilel[,libfile2...]
This option informs the Cross Linker to search the specified library files if the input object files refer
to a procedure or variable which is not defined in any of the object files. If a module of a library file
contains the referred procedure or variable, then only this module, not the whole library file will be
included in the output task file. (refer to Chapter 9 Library Manager)
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Section Address
Syntax
section name=address[,section name=address]...

This option specifies the address of the sections; section_name is the name of the section that is to be
addressed. The section name must be defined in at least one input object file, otherwise a warning
will occur. The address is the specified address whose format is xxxx in hexadecimal format.

Generate Map File

The check box of this option is to specify whether the map file is generated or not.

Linker Options
Linker options is only available for the Compiler V3.10/Assembler.

Optimize data memory: If not nesting interrupts occur in the project, select the option can save data
memory.

Remove unused function: If a function is not called, then the system will not assign space for it, this
option is enabled by default.

Uninitialized global/static varibles are automatically set to 0: If a global has no initial value, the
default initial value is 0, this value will be cleared when the program starts running.

Warn if the address of the alias variable is overlap: Check whether the address of the alias variable
is overlapping or not. If the address is address is overlapping , then a warning will be generated.

Arrange the ROM space by address order: linker will arrange the function in a small space priority
if not select this option.

Project's Build Optian,.. @

Compiler Settings | Linker Options

Categories:

[ <ol Cateqories: - ]

[] Dptimize data memary(if not nesting intermupts ocour)
Remove unused function [only for C)

[]Uninitislized glabal/static variables are autamatically set ta 0
[]'wfarm if the address of alias variable iz averlap

[]Arrange the ROM space by address arder

Check stack averflow

[ Mntirmize allncation of alnhal vaniables

»

m

(] ] [ Cancel

Fig 8-2
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Map File

The map file lists the names and loads the addresses and lengths of all sections in a program as

well as listing the messages it encounters. The Cross Linker gives the address of the program entry

point at the end of the map file. The map file also lists the names and loads addresses of all public

symbols. The names and file names of the external symbols or procedures are recorded in the map

file if no corresponding public symbol or procedure can be found. The contents of the map file are as

follows :

Input Object File: C:\t\T.OBJ
Input Object File: C:\t\STARTUP1 L.OBJ

Input Library File: C:\Program Files\Holtek MCU Development Tools\HT-IDE3000V7.81\LIB\

LIBHOLTEKGCC.LIB

Input Library File: C:\Program Files\Holtek MCU Development Tools\HT-IDE3000V7.81\LIB\v3
mrsc.lib
Input Library File: C:\Program Files\Holtek MCU Development Tools\HT-IDE3000V7.81\LIB\v3

tabrd mrsc.lib

Bank
00h
00h
00h
00h
00h
00h
00h
00h

Local Sections

Bank
00h
00h
00h
00h
00h

Start
0000h
0001h
0002h
0004h
0008h
002%n
0034h
0080h

Start
0085h
0082h
0085h
0085h
0085h

End

0000h
0001h
0002h
0007h
0028h
0033h
0038h
0081h

End

0085h
0084h
0085h
0085h
0085h

Length Class
0001h CODE
0001h CODE
0001h CODE
0004h CODE
0021h CODE
000bh CODE
0005h CODE
0002h DATA
Length Class
0000h LOCAL
0003h LOCAL
0000h LOCAL
0000h LOCAL
0000h LOCAL

Public Symbols Information

Address
0034h
0080h
002%h
0082h
0001h
0001h

Address
0001h
0001h
002%h
0034h
0080h
0082h

Public by Name
fun

9.8

_isr04

_isr04fs

_main

startup value 1

Public by Value
_main

startup value 1
_isr04

_fun

9.8

_isr04fs

Name

@code (C:\t\T.OBJ)

~main (C:\t\T.OBJ)

@ROMDATAiBASE (C:\t\STARTUPliL.OBJ)
@isr04 code (C:\t\T.OBJ)

@start (C:\t\T.OBJ)

_isr04 (C:\t\T.OBJ)

_fun (C:\t\T.OBJ)

@HCCINITO (C:\t\T.OBJ)

Name

@dummy4 (C:\t\T.OBJ)
_isr04 (C:\t\T.OBJ)
@dummy (C:\t\T.O0BJ)
_main (C:\t\T.OBJ)
_fun (C:\t\T.OBJ)
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Error(L2001) : Unresolved external symbol ' g b’ in file ‘C:\t\T.0BJ’
ROM Usage Statistics
Size Used Percentage

2000h 0038h 0%

RAM Usage Statistics

Bank Size Used Percentage
00h 0080h 0005h 3%
01lh 0080h 0000h 0%
02h 0080h 0000h 0%

Total 0180h 0005h

—
o\°

Use Stack Count
_isr04: 0
_main: 1

Call Tree
@dummy4
_1sr04
@dummy
_main
fun

Total 1 error(s), Total 0 Warning(s)

Cross Linker Task File and Debug File

One of the Cross Linker’s output files is the task file which consists of two parts, a task header
and binary code. The task header contains the Cross Linker version, the MCU name and the ROM
code size. The binary code part contains the program codes. The other Cross Linker output file
is the debug file which contains all information referred to by the IDE debugging program. This
information includes source file names, symbol names and line numbers as defined in the source
files. The IDE will refer to the symbolic debugging function information. This file should not be
deleted unless the debugging procedure is completed, otherwise the IDE will be unable to support
the symbolic debugging function.
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Chapter 9 Library Manager

In addition to the previously discussed general purpose 8-bit MCU development tools, the comapny
also supplies several other utilities for its range of special purpose Voice and LCD MCU devices by
supplying all the necessary tools and step by step guide for relevant simulation of voice synthesis
and tone generator applications as well as the tools for real time hardware LCD panel simulation.
This part contains all the information needed to program and debug relevant applications quickly
and efficiently.

What the Library Manager Does

The Library Manager provides functions to process the library files. The library files are utilized
in the creation of the output file by the Cross Linker. Alibrary is a collection of one or more object
modules which are assembled or compiled and ready for linking. It stores the modules that other
programs may require for execution.

By using the Library Manager, library files can be created. Object files including common routines
may be added to the library files. Before creating these object files, the names of all common
routines must be made public by using the assembly directive PUBLIC (refer to the chapter on
Assembly Language and Cross Assembler). The Cross Assembler generates the output object file
(.OBJ) while the Library Manager adds this object file into the specified library file. When the Cross
Linker has found unresolved names in a program during the linking process, it will search the library
files for these unresolved names, and extracts a copy of the module containing that name. If an
unresolved name has been found in this library module, the module will be linked to the program.

To Setup the Library Files

The Library Manager provides the following functions :

* Create new library files

* Add/Delete a program module to/from a library file

» Extract a program module from a library file, and create an object file

To select use the Tools Menu and the Library Manager command as shown in Fig 9-1. Fig 9-2 shows
the dialogue box for processing the functions of the Library Manager.

HT-IDE3000 - Cilsersiholtek\Documents\HTK_ProjectyHT6FESS0NHT6EFESS0.pjbe - [HTEEFESSD.c] =n E=R[==
B File Edit View Project Budd Debug | Tools | Options  Window Help -8 X
IE= == 5 ﬁ Configuration Options - i R
@ I"_I o @ % Import Configuration Options -

) B = o
F TR L M - Disgnoss
= = o Lihrary Manager
008a3D &. | _ |
— = e Program Location Manager
1
= 2 W3 Code Cenerator i
- Project: HTGGFES30 () » |,_| e
— |2 vo 7 =
G MCL HTAEFBSS0 =] ) oy Editor ’ K
_J Source Files s : LiCD Strmmlater i .
-] Startup Code o Voice & Flash Download ) ‘ )
| Work Space | 3 Class View PR Switch OCDS Made b |E2ec. [EDi [ERe. |Gt
Aotivates Library Manager Simart Programming Settings Ln3Collz  DISCONNECT Emulstion
Fig 9-1
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& HLEW =<5

Likrary Mame: C'Program Files'Holtek MCU Development

Tools HT-IDE3000W T XLIB\Ctype_mrmc ik Maw Open
Ohject in Library: Ohbject in Directory.

isainum OB

izalpha. OB
iscrirl. OB

isdligft OB

isgraph OB
islower OB EXTract
t. OB

isprinl. OB
ispunct OB

isspace 0B

isUpper OB Delete
izdigit OB

tolowver OB

Htoupper OB

Objects' information Directories:
- Browse

Maximum RAM Size : 5 words -

Minimum RAKM Size | 3 wards Acid Optian
Public Mame (_iscigh) in module tiscigt OBJ)

Public Mame (isdigtd) in module lisdigt OB

izgraph OB

Maximum ROM Size - 70 wards B
Mirimum ROM Size | 70 words ‘

¥ Remove debug info

Maximum RAM Size S words

Minimum RAM Size | 5 wards

Public Mame (_isaraph) in module Gsoraph OB
Public Mame (isaraph0) in module Gsoraph OB
islovwer OB

Maximum ROM Size : 70 words

Mlinimum ROM Size - 70 words

Maximum RAM Size S words

Minimum RAM Size : 5 words

Public Mame (_islovwer) in module Cislower OB
Public Mame (istowerd) in module (islower OB

[L.m

About Gt

Fig 9-2

Create a New Library File
Press Open button, Fig 9-3 is displayed.

Type in a new library file name and press the OK button, Fig 9-4 is displayed for confirmation. If the
Yes button is chosen, a new library file will be created but will not contain any program modules.

& Open Library File IEI

r v
(W) |}« HT-DE3000VT.x » LB ~ | 43 || Search Lig )
Organize = Mew folder =~ O '@'
45 Favorites * Mame : Date modified Type *
Bl Desktop | ctype_mrme.lib 20127456 £ 10:39  LIB Fily E‘
4 Downloads || chype_mrsc.lib 2012/3/20 5 04, LIB File—
£l Recent Places || ctype_srsclib 2012/3/20 5 04, LIBFile
E | Enable_BootLoaderlib 2016/11/18 T4 0...  LIE File
4 Libraries | Enable_BootLoader_66F43x0.lib 2016¢11/18 T4 0., LIBFile
3 Documents | Enable_BootLoader_66FB5Txlib 2016/3/24 5 0. LIB File
J‘F Pusic || HT45F_PCHM12.LIB 2010/2/22 T4 12, LIB File
| Pictures B || HT45F_UPCHE.LIE 2010/2/22 T4 12, LIB File
E YWideaos || HT45R_HTADPCMA.lib 2010410415 B 0. LIB File
| | HT45R_PCRA1Z lib 2010410415 T 0. LIBFile ™
W Cammiter - 4| 1M | 2
il mer) ~ | Library files Data (b} -

| open v | cancel |

Fig 9-3
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. Open Library File

I new.lib
LB, This file doesn't exist.

Create the file?

Yes l ’ Mo

Fig 9-4

Add a Program Module into a Library File
Select an object module from the “Object in Directory” box, and press the [ADD] button to add this
object module into this library file.

Delete a Program Module from a Library File
Select an object module from the “Object In Library” box, and press the [Delete] button to delete
this object module from the library file.

Extract a Program Module from Library and Create An Object File
Select an object module from the “Object in Library” box, and press [ExTract] button. A file will
then be created with the same name and same content as the selected object module. It is displayed
on the “Object in Directory” box.

Object Module Information
Press the Open button, Fig 9-3 is displayed. Select a library file from the box below the File Name
box, press OK button. From Fig 9-2, all the object modules of the selected library file are listed in
the “Object in Library” box. The following information about each object module is also listed in
the “Objects’ Information” box:
* Maximum ROM size
The maximum size used by this object module program code. Dependent upon the code section
align type.
* Minimum ROM size
The minimum actual size used by this object module program code.
* Maximum RAM size
The maximum size used by this object module program data. It depends on the data section align
type.
* Minimum RAM size
The minimum, actual size used by this object module program data.
* Public Name
The names of all public symbols in this object module.
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Chapter 10 Reserved Words — Used By Cross Assembler

Reserved Assembly Language Words

The following table lists all reserved words used by the assembly language.

* Reserved Names (directives, operators)

$ DUP INCLUDE NOT
* LABEL OFFSET
+ ELSE .LIST OR
- END .LISTINCLUDE ORG
ENDIF .LISTMACRO PAGE
/ ENDM LOCAL PARA
= ENDP LOW PROC
? EQU MACRO PUBLIC
[] ERRMESSAGE MESSAGE RAMBANK
AND EXTERN MID ROMBANK
BANK HIGH MOD .SECTION
BYTE IF NEAR SHL
DB IFDEF .NOLIST SHR
DBIT IFE .NOLISTINCLUDE WORD
DC IFNDEF .NOLISTMACRO XOR
ELSEIF DEFINED HIGH_NIBBLE LOW_NIBBLE
* Reserved Names (instruction mnemonics)
ADC HALT RLCA SuB
ADCM INC RR SUBM
ADD INCA RRA SWAP
ADDM JMP RRC SWAPA
AND MOV RRCA Sz
ANDM NOP SBC SZA
CALL OR SBCM TABRDC
CLR ORM SDZ TABRDL
CPL RET SDZA XOR
CPLA RETI SET XORM
DAA RL Siz
DEC RLA SIZA
DECA RLC SNz
* Reserved Names (registers names)
A | WDT WDT1 WDT2
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Instruction Sets

¢ Arithmetic Instructions

ADD A,[m]

Add Data Memory to ACC

ADDM A,[m]

Add ACC to Data Memory

ADD A x

Add immediate data to ACC

ADC A,[m]

Add Data Memory to ACC with carry

ADCM A,[m]

Add ACC to Data Memory with carry

SUB A, x

Subtract immediate data from ACC

SUB A,[m]

Subtract Data Memory from ACC

SUBMA,[m]

Subtract Data Memory from ACC with result in Data Memory

SBCA,[m]

Subtract Data Memory from ACC with carry

SBCM A,[m]

Subtract Data Memory from ACC with carry and result in Data Memory

DAA [m]

Decimal adjust ACC for addition with result in Data Memory

* Logic Operation Instructions

AND A [m]

AND Data Memory to ACC

OR A,[m]

OR Data Memory to ACC

XORA,[m]

Exclusive-OR Data Memory to ACC

ANDM A,[m]

AND ACC to Data Memory

ORM A,[m]

OR ACC to Data Memory

XORM A, [m]

Exclusive-OR ACC to Data Memory

AND A x

AND immediate data to ACC

ORAx

OR immediate data to ACC

XORA,x

Exclusive-OR immediate data to ACC

CPL [m]

Complement Data Memory

CPLA[m]

Complement Data Memory with result in ACC

¢ Increment & Decrement Instructions

INCA [m]

Increment Data Memory with result in ACC

INC [m]

Increment Data Memory

DECA [m]

Decrement Data Memory with result in ACC

DEC [m]

Decrement Data Memory

¢ Rotate Instructions

RRA [m]

Rotate Data Memory right with result in ACC

RR [m]

Rotate Data Memory right

RRCA [m]

Rotate Data Memory right through carry with result in ACC

RRC [m]

Rotate Data Memory right through carry

RLA [m]

Rotate Data Memory left with result in ACC

RL [m]

Rotate Data Memory left

RLCA [m]

Rotate Data Memory left through carry with result in ACC

RLC [m]

Rotate Data Memory left through carry
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e Data Move Instructions

MOV A,[m] Move Data Memory to ACC
MOV [m],A Move ACC to Data Memory
MOV A,x Move immediate data to ACC

* Bit Operation Instructions

CLR [m].i

Clear bit of Data Memory

SET [m].i

Set bit of Data Memory

¢ Branch Instructi

ons

JMP addr Jump unconditionally

SZ [m] Skip if Data Memory is zero

SZA [m] Skip if Data Memory is zero with data movement to ACC
SZ [m].i Skip if bit i of Data Memory is zero

SNZ [m].i Skip if bit i of Data Memory is not zero

SIZ [m] Skip if increment Data Memory is zero

SDZ [m] Skip if decrement Data Memory is zero

SIZA [m] Skip if increment Data Memory is zero with result in ACC
SDZA [m] Skip if decrement Data Memory is zero with result in ACC
CALL addr Subroutine call

RET Return from subroutine

RET A,x Return from subroutine and load immediate data to ACC
RETI Return from interrupt

e Table Read Instructions

TABRDC [m]

Read ROM code (current page) to Data Memory and TBLH

TABRDL [m]

Read ROM code (last page) to Data Memory and TBLH

* Miscellaneous Instructions

NOP No operation

CLR [m] Clear Data Memory

SET [m] Set Data Memory

CLR WDT Clear Watchdog Timer

CLR WDT1 Pre-clear Watchdog Timer

CLR WDT2 Pre-clear Watchdog Timer

SWAP [m] Swap nibbles of Data Memory

SWAPA [m] Swap nibbles of Data Memory with result in ACC
HALT Enter Power Down Mode
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Chapter 11 LCD Simulator

Introduction

The Holtek LCD simulator, known as the HT-LCDS, provides a mechanism allowing users to
simulate the output of LCD drivers. According to the user designed patterns and the control
programs, the HT-LCDS displays the patterns on the screen in real time. It facilitates the
development process even if the actual LCD hardware panel is unavailable. Note that if the current
project’s microcontroller does not support LCD functions, these commands are disabled. Only the
HT-ICE and e-Link support the LCD simulator function.

LCD Panel Configuration File

Before starting the LCD simulation, an LCD panel configuration file must first be setup. The HT-
LCDS will obtain the LCD data and display LCD patterns on the screen according to the LCD
panel configuration file. The HT-LCDS cannot simulate the LCD action if this file is absent. For
microcontrollers possessing an LCD driver, the corresponding panel configuration file has to be
setup for LCD simulation. The LCD simulator command within the Tools menu will then be enabled
to setup the panel configuration file and for simulation (Fig 11-1). The LCD panel configuration file
contains two kinds of data, panel configuration data and pattern information, which users can setup
using the HT-LCDS.

hitd: HT-IDE3000 - C-WCHACH3 pit
Fils Edit View Project Build Debug [WESB Options Window Help
Configumation Options B aEE-D & ™00
Disgnnse
Briter ’

Libirary Mansger
Editor »

LCD Simulstor

Lnl, Coll LFTL Emulation FC=0001H OVR CAF NUM

Fig 11-1

Relationship Between the Panel File and the Current Project

By default, the panel configuration file has the same file name as the current project name except
for the extension name, which is .lcd. The HT-LCDS assumes this file to be the corresponding panel
configuration file of the current project. The panel configuration file is generated by the HT-LCDS
File menu, New command or the New button on the toolbar. A different file name from the current
project name can be assigned to the panel configuration file by clicking File menu,Save command or
Save button on the toolbar.

When the HT-LCDS begins simulation, it references the current active panel configuration file to
obtain its simulation information. The LCD panel configuration file is activated by selecting the
New or Open command of the HT-LCDS File menu. The file name of the LCD panel configuration
file may be the same as the current project name or a different name can be chosen.

Selecting the HT-LCDS

When selected from within the Tools menu, the LCD simulator as shown in Fig 11-2 is displayed if
the corresponding panel configuration file of the current project exists. The file name of each bitmap
pattern is shown at the specified COM/SEG position of the table. At the same time, these patterns
are shown on the above panel screen. If the corresponding panel configuration file does not exist
within the project directory, both the panel screen and the COM/SEG table will not be displayed. Fig
11-3 shows the HTLCDS menu bar information.
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The Fig below shows the HT-LCDS menu bar information.
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Information

Fig 11-3
New: create a new panel configuration file

Open: open an existing panel configuration file

Save: save the panel configuration file

Cut: delete a pattern

Copy: copy a pattern to the clipboard

Paste: add the copied pattern to the panel

I: panel information dialog

S: enter the LCD simulation mode

LCD Panel Picture File

The LCD panel picture (pattern) file is a bitmap file (.bmp) which represents the practical patterns
and their positions on the panel. The bitmap file can be created using any bitmap editor and provides
another method of setting up the LCD panel pattern information by using the HT-LCDS Edit
menu, Panel Editor command. The bitmap file is optional, users can setup the LCD panel pattern
information even if the LCD panel picture file is absent.

Setup the LCD Panel Configuration File
The following two steps are used to setup a panel configuration file:

» Setup the panel configurations, including the segment and common number of the LCD driver
as well as the width and height size of the panel in pixels. Also, the directory of the panel
configuration file and the dot matrix mode can be selected.

 Select the patterns and their positions. This will setup the relationship between the patterns and
the COM/SEG positions.
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Setup the Panel Configurations
To setup the panel configurations by selecting the HT-LCDS File menu, New command. The Panel
Configuration dialog box (Fig 11-4) will be displayed. Setup the correct LCD driver data, COM/
SEG number, Width, Height and Directory of the pattern, then press the [OK] button. After setting
up the panel configuration, the system returns to Fig 11-2 for pattern selection.

Panel Configuration E]
COm 4 :|: SEG 16 _I

Width | 400 Height| 100-3

1

HT
VED
LCD

Pattern file position {BMP)
CAProgram FilesiHoltek MCL Development Toolsik

[ Systern default Matrix (0] Cancel

Fig 11-4
The panel configurations include:

* The default number of the LCD driver for this microcontroller is displayed when Fig 11-4 is
displayed. To ensure that these numbers are the same as the actual setting number of the LCD
driver for the micro controller.

* Width and Height. These are the size of the panel screen in pixels and can be changed to adjust
the panel screen.

+ Panel configuration file directory. Select the directory where the panel configuration file is stored
using the browse button or setup to have the same directory as the project.

* Dot Matrix Mode. To simulate dot matrix type LCD panels. Fig 11-5 shows the dot matrix
screen.

Fig 11-5

Note: It is important not to set different COM or SEG number from the actual corresponding LCD
driver numbers, otherwise unpredictable results will occur.

Select the Patterns and Their Positions

The following methods show the steps of selecting the patterns and their positions

* To create a new panel configuration file using the HT-LCDS File menu New command. After
having set the panel configuration, Fig 11-2 is displayed. The user then has to select the patterns
from the Pattern Information dialog box (Fig 11-6) and set the COM/SEG positions. The section,
Add a new pattern, describes the procedure in detail.
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Add a

To open an existing panel configuration file using the HT-LCDS File menu Open command. The
patterns are displayed as shown on the panel screen in Fig 11-2 and the pattern file names are
displayed as shown in the Fig 11-2 COM/SEG table position. Users can add/delete/change the
pattern information, including the pattern file and pattern positions.

To open a panel picture file using the HT-LCDS Edit menu Panel Editor command. If this
panel picture file has been setup already, then it is not necessary to select the patterns, it is only
necessary to select the pattern positions. The section, Define the pattern using the Panel Editor,
describes the procedure in detail.

New Pattern

Move the cursor to a COM/SEG position on the grid as shown in Fig 11-2 and double click the
mouse. The Pattern Information dialog box, as shown in Fig 11-6, is displayed. All the pattern
files (.bmp) in the project’s directory are listed in the Pattern List box. The Size field is the
bitmap size of the selected pattern, Com and Seg fields are the numbers of the selected COM/
SEG position of this pattern. None of these three fields can be modified.

Select a pattern, a bitmap file, from the Pattern List box, or click the Browse button to change to
another directory and select a pattern from that directory. The HT-LCDS uses 2-color bitmap files
as the image source of patterns. The Preview-window zooms into the selected pattern.

Set the X/Y positions in the panel screen for the selected pattern.

Press the [OK] button and return to Fig 11-2, then click the File menu, Save command or click
the Save button on the toolbar. The panel file has now been created or modified.

— Plesew Faifem Ll Size 1716
Com:0
’ CONTINUE Segil

xm

B
2] i1 sPEAKER
. ;I Cancel |
Pattern Dircctory: Browse |
[
|c:l|,l-|T-IDE\,s.|ﬁAPLE

Fig 11-6

Delete a Pattern

As shown in Fig 11-2, select the COM/SEG position of the pattern to be deleted and press the
[Delete] key or click the Cut button on the toolbar.

Change the Pattern

Delete the selected pattern first, then add a new pattern to change the pattern.

Alternatively, as shown in Fig 11-2, select the COM/SEG position of the selected pattern and
double click the mouse. The Pattern Information dialog box, as shown in Fig 11-6, is displayed.
Select a pattern from the Pattern List box and press the [OK] button.
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Change the Pattern Position
* As shown in Fig 11-2, use the Select-Drag-Drop method to move the pattern directly onto the
panel screen.
* Alternatively, as shown in Fig 11-2, double click the COM/SEG position of the selected pattern.
The Pattern Information dialog box, in Fig 11-6, is displayed. Set the X, Y value of the new
position and press the [OK] button.

When the above operations have been completed and the system has returned to that shown in Fig

11-2, click the HT-LCDS File menu, Save command or click the Save button on the toolbar. The
panel file has now been created or modified.

How to Add a User-define Matrix
The HT-LCDS supports a mapping strategy (File menu, Import user matrix command) which can
help define a new matrix if the COM/SEG number is not equal to the ROW/COL number of the
LCD panel. For example, Assume there is an LCD panel of 2 COMs and 6 SEGs, and assuming this
LCD panel is a 3 ROWs 4 COLs matrix, as shown in the following mapping

COMO0-SEGO COMO0-SEG1 COMO0-SEG2 COMO-SEG3
COM1-SEGO0 COM1-SEGH1 COM1-SEG2 COM1-SEG3
COMO-SEG4 COMO-SEG5 COM1-SEG4 COM1-SEG5

A definition file for the above matrix can be defined as follows,

; MATRIX.DEF

; Comment line

ROW=3

COLUMN=4

; mapping syntax,ROW,COL=>COM, SEG

0,0 = 0,0 ; Map Row0 col0 to COMO SEGO
0,1 = 0,1 ; Map Row0 coll to COMO SEG1
0,2 => 0,2 ; Map Row0 col2 to COMO SEG2
0,3 =>0,3 ; Map Row0 col3 to COMO SEG3
1,0 => 1,0 ; Map Rowl col0 to COM1 SEGO
1,1 => 1,1 ; Map Rowl coll to COMl SEGL
1,2 => 1,2 ; Map Rowl col2 to COML SEG2
1,3 =>1,3 ; Map Rowl col3 to COML SEG3
2,0 => 0,4 ; Map Row2 col0 to COMO SEG4
2,1 =>0,5; Map Row2 coll to COMO SEG5
2,2 => 1,4 ; Map Row2 col2 to COMl SEG4
2,3 =>1,5; Map Row2 col3 to COML SEGH

Define the Pattern Using the Panel Editor
The HT-LCDS supports a full panel edit interface to define the LCD panel patterns. If a panel picture
file has been drawn already, then it is not necessary to set all pattern files in the panel respectively.
The only requirement is to select the pattern positions.
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The following steps select the pattern positions for all the patterns in the LCD panel

» Invoke the Panel Editor by selecting the Edit command, Panel Editor command after having set
the panel configuration

+ Select the File menu, Open command in the Panel Editor to open the panel picture file (.bmp)

Note: Supports 2-color .BMP only

 The panel will be displayed in the window as in Fig 11-7

+ Select the pattern for each COM/SEG by using double-click or drag-and-drop methods.The Save
Pattern dialog box will be displayed after which the pattern information can be entered.

* Repeat the above step for all patterns in the panel.

» After having set the pattern information for all patterns, return to the Panel Editor window and
save all the settings using the File menu Save command.

» Exit the Panel Editor and return to the HT-LCDS, the panel will now display the new settings.

Add New Pattern Items Using a Batch File
The HT-LCDS provides a method to add pattern items from a batch file using the Edit menu and
Add Item Batch command. The batch file is a text file with an extension name .BTH. All the pattern
items in the batch file will define the pattern file name and its positions. After selecting a batch file
using the Edit menu’s Add Item Batch command, the HT-LCDS adds all patterns depicted in the
batch file at the specified positions of the panel. The following is an example of a .BTH file.
;this is a comment line.

;item syntax: BMPfile.bmp, COM, SEG, X, Y
CRYSTAL.BMP, 0, 2, 120, 30

FION.BMP, 2, 3, 200, 50
CLIN.BMP, 3, 2, 130, 90
STEVE.BMP, 4, 4, 20, 40

Selecting Color for an LCD Panel
The HT-LCDS provides a palette dialog, as shown in Fig.11-8, for selecting the colors of the panel
using the HT-LCDS Configure menu and Set Panel Color command.
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Fig 11-8

Note: The ECB mode is for HTG21x0 color LCD only.

Setting Pattern Color for VFD Panel

The HT-LCDS provides an interface, as shown in Fig.11-9, for setting the color of each pattern for
Holtek’s VFD MCU (eg. HT49CVX series) Select Configure menu and execute the Set VFD pattern
Color command to accomplish this setting.

Set YFD pattern color

E..O

iy Grid- 0,Seqg- 0

Grid- 0

-4 Grid- 0,5eg- 1
- Grid- 0,5eg- 2
R JGrid-0.5eq-3
- Grid- 0,5eg- 4
-y Grid- 0,5eg-5

Grid- 0,5eg- b

-y Grid- 0,5eg-7
-y Grid- 0,5eg- 8
-y Grid- 0,5eg-9
-4 Grid- 0,Seg-10
-y Grid- 0,5eg-11

Grid- 0,5eg-12
Grid- 0,5eg-13

OK

Cancel

Fig 11-9
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Fig 11-10

Simulating the LCD

Before starting the LCD simulation, ensure that the HT-LCDS refers to the correct panel
configuration file. Enter the HT-LCDS environment by selecting the Tools menu, LCD Simulator
command as shown in Fig 11-1 and Fig 11-2.

* Click once the S button on the toolbar allowing the HT-LCDS to begin LCD simulation while
referring to the corresponding panel configuration file.

* Open a panel configuration file which is not the corresponding panel configuration file of
the current project and click the S button on the toolbar. The HT-LCDS will then begin LCD
simulation while referring to the opened panel configuration file.

When the HT-LCDS begins simulation, a window as shown in Fig 11-11 will be displayed while the

most recent LCD patterns will be displayed on the panel screen.

Stop the Simulation

Double click the title bar of the LCD simulation window to make the HT-LCDS return to the edit

mode.

Haoltek LCD S rmulator

Fig 11-9
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care and attention before publication, however, Holtek does not guarantee
that the information is completely accurate and that the applications provided
in this document are for reference only. Holtek does not guarantee that these
explanations are appropriate, nor does it recommend the use of Holtek's products
where there is a risk of personal hazard due to malfunction or other reasons.
Holtek hereby declares that it does not authorise the use of these products in
life-saving, life-sustaining or critical equipment. Holtek accepts no liability for any
damages encountered by customers or third parties due to information errors
or omissions contained in this document or damages encountered by the use
of the product or the datasheet. Holtek reserves the right to revise the products
or specifications described in the document without prior notice. For the latest
information, please contact us.
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